
 

Setting Up Your
Power Mac G4

 

Includes setup and expansion information
for Power Mac G4 computers



 

K

 

Apple Computer, Inc.

 

© 

 

2002 Apple Computer, Inc. All rights reserved. 

Under the copyright laws, this manual may not be copied, in whole or in part, without the written consent of Apple.

The Apple logo is a trademark of Apple Computer, Inc., registered in the U.S. and other countries. Use of the 
“keyboard” Apple logo (Option-Shift-K) for commercial purposes without the prior written consent of Apple may 
constitute trademark infringement and unfair competition in violation of federal and state laws.

Every effort has been made to ensure that the information in this manual is accurate. Apple is not responsible for 
printing or clerical errors.

Apple Computer, Inc.
1 Infinite Loop
Cupertino, CA 95014-2084
408-996-1010
www.apple.com 

Apple, the Apple logo, AirPort, Apple Store, AppleShare, AppleTalk, Final Cut Pro, FireWire, the FireWire logo, 
Keychain, Mac, Macintosh, Power Mac, QuickTime, and Sherlock are trademarks of Apple Computer, Inc., registered 
in the U.S. and other countries.

DVD Studio Pro, Finder, iMovie, iPhoto, iPod, and iTunes are trademarks of Apple Computer, Inc.

AppleCare is a service mark of Apple Computer, Inc.

Digital imagery copyright 2001 Photodisc, Inc.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems, Inc. in 
the U.S. and other countries.

PowerPC and the PowerPC logo are trademarks of International Business Machines Corporation, used under 
license therefrom.

Manufactured under license from Dolby Laboratories. “Dolby” and the double-D symbol are trademarks of Dolby 
Laboratories. Confidential Unpublished Works. 

 

©

 

 1992–1997 Dolby Laboratories, Inc. All rights reserved.

This product includes software developed by the University of California, Berkeley, and its contributors.

Other company and product names mentioned herein are trademarks of their respective companies. Mention of 
third-party products is for informational purposes only and constitutes neither an endorsement nor a 
recommendation. Apple assumes no responsibility with regard to the performance or use of these products.

Simultaneously published in the United States and Canada.

Sherlock’s Yellow Pages channel may be known by a different term outside the United States. 



       
Contents
1 Setting Up     7

Positioning the Computer and Display     7

Plugging In the Computer     8

Need Help?     12

When You’re Not Using the Computer     13

Adjusting Your Display     13

Getting to Know Your Computer     14

Ports and Connectors—Expanding Your Computer’s Capabilities     16

Inside Your Power Mac—Your Computer’s Internal Expansion Options     18

What’s Next?     20

2 Getting Started With Your Computer     21

For the Latest Information     21

About Mac OS X     22

Sherlock—Your Internet Search Detective     24

.Mac—Internet Services for Mac Users     26

Apple.com—Your Starting Place on the World Wide Web     28

QuickTime—Audio and Video on the Internet     30

iPhoto—Import, Organize, Share, and Edit Your Digital Pictures     32

iMovie—Create and Edit Your Own Digital Movies     34

iTunes—Digital Music for Your Mac     36

Software Update—Keep Your Mac on the Cutting Edge     38

Multiple Users—One Mac for Many Users     40

Mac Help—Answers to Your Macintosh Questions     42
  3



           
3 Working With Your Operating System     43

About Mac OS X     43

Using Classic in Mac OS X     44

Switching Between Operating Systems     44

Need Help?     45

4 Using Your Computer     47

Using Your Apple Pro Keyboard and Apple Pro Mouse     48

Connecting a Second Display to Your Computer     50

Using USB Devices     51

Using FireWire Devices     53

Using Your Optical Drive     55

Using Your Modem     57

Connecting to an Ethernet Network     58

Using AirPort Wireless Networking     60

Putting the Computer to Sleep to Save Energy     62

Attaching SCSI Devices to Your Computer     63

Transferring Information Between Two Macintosh Computers     63

Using the Computer as a Server Without a Monitor     64

5 Working Inside Your Computer     65

Opening the Computer     66

Installing Memory     69

Installing Internal Storage Devices     71

Installing a PCI Expansion Card or Replacing the AGP Card     79

Installing an AirPort Card     82

Replacing the Battery     83

6 Troubleshooting     85

Software Problems     87

Problems With Your Display     88

Restoring Your Computer’s Software     90

Appendix  A
Specifications     91
4 Contents   



    
Appendix  B
Safety, Maintenance, and Ergonomics     97

Important Safety Information     97

General Maintenance     99

Important Ergonomic and Health-Related Information     100
  Contents 5





   

C H A P T E R

 

1

               
1 Setting Up
Congratulations on purchasing your new Power Mac G4 computer. Your Power Mac G4 is a 
full-featured computer that includes the latest in computer technology such as FireWire, 
USB, support for AirPort wireless Internet and networking, and the latest Macintosh 
operating system, Mac OS X. This chapter contains instructions for setting up your computer 
and display. 

Positioning the Computer and Display

You can pick up the computer by any of its handles. If your monitor (or display) is heavy, be 
sure to use correct lifting techniques when positioning it. Position the computer and display 
so that

m they are on sturdy, flat surfaces

m the power cable connectors don’t press against a wall or other object

m nothing obstructs air flow behind or below the display or computer

m the computer’s optical drive tray has space to open in front

Important  The only way to shut off power completely to your computer and display is to 
disconnect their power plugs from the power source. Make sure the power cords for your 
computer and display are within easy reach.
 7



           
Plugging In the Computer

1 Set the voltage switch on the back of your computer to the correct voltage, if necessary.

m If your computer doesn’t have a voltage switch, the correct voltage is set automatically 
and you can skip this step.

m If your computer has a voltage switch, make sure the voltage switch is set for the voltage 
system in your country.

The voltage switch must be set correctly to avoid damaging your computer.

Set the switch to show “115” for AC voltages in
the 100–120V range. Set the switch to show
“230” for AC voltages in the 200–240V range.

Your computer may have a voltage switch on the back.
If you need to change the setting, insert a small screwdriver
in this slot and slide the switch.
8 Chapter  1  



              
 

2 Plug the power cord firmly and completely into the recessed power socket marked with the 
symbol ≤ on the back of the computer and plug the other end into a grounded outlet or 
power strip.

Country Switch setting

Bermuda, Canada, Jamaica, Japan, Mexico, Philippines, Puerto Rico, 
Saudi Arabia, Taiwan, United States, Venezuela 

115

Bahrain, Brazil, France, Indonesia, Italy, Lebanon, Peru, South Korea, 
Spain1 

115 or 230

Argentina, Australia, Austria, Belgium, Bosnia and Herzegovina, Chile, 
China (People’s Republic including Hong Kong), Croatia, Czech 
Republic, Denmark, Egypt, Finland, the Former Yugoslav Republic of 
Macedonia, Germany, Greece, Greenland, Hungary, Iceland, India, 
Iran, Ireland, Israel, Jordan, Kuwait, Liechtenstein, Luxembourg, Malta, 
Nepal, the Netherlands, New Zealand, Northern Ireland, Norway, 
Oman, Pakistan, Papua New Guinea, Paraguay, Poland, Portugal, Qatar, 
Romania, Russia and the Commonwealth of Independent States (CIS), 
Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa, 
Sweden, Switzerland, United Arab Emirates, United Kingdom, Yemen

230

1 These countries employ more than one type of power source voltage. Ask your local power provider which switch setting to 
use for your city or region.

Power cord plug

Power cord socket
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3 Connect your display cables according to the following illustration: 

Your video card has these monitor ports:

m An Apple Display Connector (ADC) port to connect Apple flat-panel displays 

m A Digital Visual Interface (DVI) port to connect digital displays that have 
DVI connectors

m To connect a VGA monitor, use a DVI to VGA adapter (supplied with your computer) to 
connect the monitor to the DVI port 

m To connect a second ADC display, use a DVI to ADC adapter (not supplied) to connect the 
display to the DVI port.

For more information about connecting a second display, see the guidelines in Chapter 4, 
“Using Your Computer.”

Important  Depending on your monitor, you may have one or more cables to connect. 
Check the instructions that came with the monitor for further setup information.

USB ports

Monitor cableMonitor ports

DVI monitor portADC monitor port
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4 If required, connect your computer to your Ethernet network or connect your modem port 
to a phone line.

5 Connect the keyboard cable to one of the USB ports ( ) on the computer or on your display. 
Plug the mouse cable into a USB port on the keyboard.

Modem port

Ethernet port

Parts of your computer
may be covered by clear
plastic film that protected
it during shipment. You
can remove the film.Keyboard Mouse

USB ports on keyboard (2)

Don’t put anything in the recessed
speaker opening. Touching the

speaker can damage it.
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If you wish, raise the keyboard by lifting it and flipping the foot toward the back. 

Turn on your computer by pressing the power button (®) on the front of the computer. 
With some displays, you can also turn on the computer using the display’s power button. If 
your display must be turned on separately, turn it on by pressing its power button.

Need Help?

If you don’t see anything on your screen or you think your computer did not start up 
properly, check these items:

m Is the computer plugged into a power source? If it is plugged into a power strip, is the 
power strip turned on?

m Are the keyboard and display cables connected correctly? 

m Is the power button lit on the front panel of the computer and on the display? If not, the 
computer or display isn’t receiving power or is off.

m Is the display turned on? Are the brightness and contrast controls on the display adjusted 
correctly? If your display has brightness and contrast controls, adjust them.

m Restart your computer. Press the computer’s power button for approximately 5 seconds 
until the computer turns off. Press it again to turn the computer on.

m If you see a blinking question mark on the screen or hear a series of beeps when you turn 
on the computer, see Chapter 6, “Troubleshooting,” on page 85.
12 Chapter  1  



            
When You’re Not Using the Computer

Your computer is set to go to sleep after a period of inactivity. Sleep is a state in which your 
computer is on but uses very little power. To wake your computer from sleep, press any key. 
You can also put the computer to sleep whenever you want, or set your computer so it never 
goes to sleep. For more information on sleep, see “Putting the Computer to Sleep to Save 
Energy” on page 62. 

If you’re not going to use the computer for a few days, you should turn it off.

To turn off your computer, choose Shut Down from the Apple (K) menu.

Adjusting Your Display

To adjust the settings for your display, choose System Preferences from the Apple (K) menu 
and click Displays.

For information about troubleshooting your display, see “Problems With Your Display” on 
page 88. For information about maintaining your display, see “Maintaining Your Display” on 
page 100. Additional information about using your display is available in Mac Help. 

Important  Do not turn off the computer by turning off the switch on a power strip or by 
pulling the computer’s power plug (unless you can’t turn off the computer any other way). 
Your files or system software could be damaged if your computer is not shut down properly.
 Setting Up 13



   
Getting to Know Your Computer

Optical drive

Speaker

Reset buttonP

Programmer’s
button

¥

Zip drive
(optional)

Power button/
Status light

Media Eject key
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Optical drive

Your computer may have a CD-RW drive or a Combo drive (DVD-ROM/CD-RW ). Both 
drives can read CD-ROM discs, Photo CDs, standard audio discs, and other kinds of media. 
The Combo drive can also read DVD discs and DVD movies and write music, documents, 
and other digital files on CD-R and CD-RW discs. To open the optical drive, press the Media 
Eject (C) key on your Apple Pro Keyboard.

Zip drive (optional)

Store and back up information on removable Zip disks. If you purchased a Zip drive, it is 
installed here. 

® Power button/Status light

Press this button to turn on the computer or wake it from sleep. When the computer is on, 
press the power button to put the computer to sleep. A white light indicates that the 
computer is on. A pulsing light indicates the computer is in sleep. 

With some Apple displays, you can also touch or press the monitor’s power button to turn 
the computer on or put it to sleep.

P Reset button

This button forces the computer to restart. Use the reset button only when you cannot 
restart your computer with any of the recommended methods, such as choosing Restart 
from the Apple (K) menu in Mac OS X, or choosing Restart from the Special menu in 
Mac OS 9. For more information about when to use the reset button, see Chapter 6, 
“Troubleshooting,” on page 85.

¥ Programmer’s button

This button interrupts the normal operation of the computer’s software. Only use this 
button for firmware updates. The firmware update documentation includes directions for 
using this button.

Speaker

The recessed internal speaker is designed for optimum sound fidelity. Don’t let anything 
touch the fragile speaker mechanism. 

C Media Eject key

The Media Eject key on the Apple Pro Keyboard opens the optical drive and ejects CD and 
DVD discs.

On some keyboards, you can also use the F12 key to eject discs and open the optical drive.
 Setting Up 15



   
Ports and Connectors—Expanding Your Computer’s Capabilities

Lockable cover latch

Internal modem port
(optional)

Headphone jack

Power socket

Ethernet port

Apple speaker mini-jack

FireWire ports (2)

USB ports (2)

G

W

≤

Access covers for
expansion slots
(Slots 2–5: PCI)Security lock portF

f

ADC monitor port

DVI monitor port
(Slot 1: AGP)
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f Headphone jack

Connect your Macintosh to headphones, externally powered (amplified) speakers, or other 
audio output equipment. For more information about the kinds of speakers you can 
connect, go to the Apple World Wide website at www.apple.com/store 

Apple speaker mini-jack

Connect your Macintosh to high-fidelity Apple Pro speakers to play stereo music and 
sound for multimedia, games, audio CDs, and more. See “Adjusting the Sound While 
Playing DVD and Audio Discs” on page 55 for information about using your speakers. 

FireWire ports

Connect your Macintosh to FireWire devices, including digital video cameras, scanners, and 
hard disk drives. FireWire provides a high-speed method of data transfer between them all.

USB ports

Connect your Macintosh to USB devices, such as keyboards, mouse devices, printers, 
scanners, speakers, USB microphones, and USB hubs. Your display may also have USB 
ports for connecting USB devices.

Monitor ports

Connect your Macintosh to monitors that use an Apple Display Connector (ADC) or a 
Digital Visual Interface (DVI) connector.

F Security lock port and lockable cover latch

You can attach a security lock to your Macintosh and to its back panel to secure the 
internal components. When the lockable cover latch is pulled out, you can insert a security 
cable or lock to prevent the computer cover from opening. See your computer products 
retailer for security lock devices that will work with your computer.

W Internal modem port

Connect a phone cord to the internal modem.

≤ Power socket

Connects to the computer’s power cord.

G 10/100/1000 twisted-pair Ethernet port 

Connect your Macintosh to a high-speed Ethernet network so that you can access network 
resources, such as printers and servers, and share information with other computers over 
the network.

Access covers for expansion slots (4)

Your Macintosh supports up to four Peripheral Component Interconnect (PCI) cards. The 
covered slots, labeled 2, 3, 4, and 5, provide additional expansion capability. In some 
configurations, an Ultra160 low-voltage differential (LVD) SCSI card is installed in one of 
these slots.
 Setting Up 17



   
Inside Your Power Mac—Your Computer’s Internal Expansion Options

Slot 1: AGP slot
(graphics card installed)

SDRAM slots (3)

BatteryAirPort Card connector

Slots 2–5: 33 MHz PCI slots (4)Drive position 3

Drive position 2

Drive position 1
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Hard disk drive carriers

You can install additional hard disk drives in these carriers inside your computer. If you are 
using ATA hard disk drives, you can install up to two ATA drives in the single U-shaped 
carrier (position three). If you are using SCSI hard disk drives, you can install up to three 
SCSI drives in the drive carriers.

AirPort Card connector

Connects an AirPort Card, which allows your computer to communicate with a wireless 
network.

PCI expansion slots

You can install PCI cards in these slots to expand your computer’s capabilities. For 
example, you can install a SCSI PCI card and then connect and use SCSI devices such as 
scanners, hard disk drives, and Zip drives.

AGP graphics slot

Connects your advanced graphics port (AGP) card, which provides fast graphics processing 
power, to your monitor. You can connect a monitor that has an Apple Display Connector 
(ADC) or a Digital Visual Interface (DVI) connector. 

SDRAM slots

You can install additional memory in your computer by inserting up to 3 DRAM DIMMs in 
the memory slots. You can expand your computer’s memory up to 1536 MB (1.5 GB).

Battery

Your computer uses a battery that you rarely replace. If you find that your computer is 
having trouble starting up, or that the system date and time are frequently incorrect, you 
may need to replace the battery. For more information, see “Replacing the Battery” on 
page 83.
 Setting Up 19



What’s Next?
m For an overview of your computer’s software features, see Chapter 2, “Getting Started 

With Your Computer,” on page 21.

m For information about your Macintosh operating systems, including instructions on how 
to switch between Mac OS X and Mac OS 9, see Chapter 3, “Working With Your Operating 
System,” on page 43.

m For more information about using your modem, connecting to a network, or using the 
computer’s other hardware features, see Chapter 4, “Using Your Computer,” on page 47.

m For information about installing additional drives, memory, or PCI cards or changing the 
computer’s battery, see Chapter 5, “Working Inside Your Computer,” on page 65.

m To register your new computer with Apple, use the Setup Assistant. You can also register 
your computer, Apple display, or Apple software on the Apple website at www.apple.com/
register 
20 Chapter  1  
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2

2 Getting Started With Your Computer

If you’re eager to get started and want to try out a few things, this chapter is for you. It 
provides an overview of your computer’s software features along with the unique Internet 
services available to Mac owners. 

Your computer comes with two Macintosh operating systems installed:  Mac OS X and 
Mac OS 9. Your computer is set to start up in Mac OS X, but you can set it to start up in the 
Mac OS you prefer, and then easily switch between the two. For instructions on how to 
switch your startup Mac OS, or for more information about the operating systems on your 
computer, see Chapter 3, “Working With Your Operating System,” on page 43.

Mac OS X includes powerful features that you can use to connect to the Internet to watch 
video, research information, shop, and even update your software automatically. With your 
Power Mac G4, you also get some of the latest Apple software for creating multimedia 
masterpieces. Use Mac OS X and iPhoto to import, organize, edit, and share your digital 
photos. Connect your digital video camera and create your own desktop movies with iMovie, 
or play music files with iTunes. 

Apple also provides Internet services that give you storage space on the Internet, a personal 
Mac.com email address, tools to easily create your own website or iMovie theater, and more. 

Note:  Because Apple frequently releases new versions and updates to its system software, 
applications, and Internet site, images shown in this manual may be slightly different from 
what you see on your screen.

For the Latest Information

The Apple website links you to technical support, the latest Apple news, free downloads, and 
online catalogs of software and hardware for your Mac at www.apple.com

You can also find the manuals for many Apple products on the AppleCare Service and 
Support website at www.apple.com/support
 21



About Mac OS X

Apple menu

Use this to 
change settings, 

open recently 
used items, and 
shut down your 

computer.

Window with 
buttons

Click a button to 
close the window, 
minimize it in 
the Dock, or 
enlarge it.

Finder toolbar

Click to open 
folders, files, and 
shortcuts to 
places on your 
computer. 

Dock

Click an icon in the Dock to open 
that item or make it active. Some 
icons in the Dock indicate the  
status of an application.

Sheet

Sheets for 
saving and printing 

are attached to 
document 
windows.

Button

If a button pulses, 
you can press the 

Enter or Return 
key instead of 

clicking it.

Status icons

Check the  
status of system 
preferences from 
the menu bar.
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What You Can Do

Mac OS X provides a powerful and elegant new user interface for your computer. With 
Mac OS X, you don’t need to worry about the amount of memory to allot for an application 
to run efficiently, or restarting your computer if something goes wrong with an application. 
In addition to using Mac OS X software, you can still run Mac OS 9 versions of software 
in Mac OS X using the Classic environment. Chapter 3, “Working With Your Operating 
System,” on page 43 explains Classic in more detail. Mac OS X also supports Java and 
UNIX-based software.

To Get Started

System Preferences is your command center for all of your computer settings, from changing 
the appearance of your desktop to setting up network access information. The Finder and 
Dock provide easy access to folders, applications, documents, and other items on your 
computer and network. 

For details on the features of Mac OS X, see the Welcome to Mac OS X book that came with 
your computer or choose Mac Help from the Help menu in Mac OS X.

Tips and Tricks

Personalize the Finder

Select a picture or color for your desktop by choosing System Preferences from the Apple (K) 
menu and clicking Desktop. You can drag an image to the well or choose one from the Apple 
Background Images collection. 

You can also select and rearrange the items that appear in the toolbar in Finder windows. 
Choose Customize Toolbar from the View menu and drag items to the toolbar.

Personalize the Dock

You can change the size of the Dock icons and turn on magnification so that the icons under 
your pointer become larger than the rest of the Dock. Choose Dock from the Apple (K) menu, 
then choose Dock Preferences. You can also open System Preferences from the Apple (K) 
menu and click Dock.

Keep your desktop organized

Reduce the clutter on your desktop by minimizing open windows, which puts them in the 
Dock. Double-click a window’s title bar or click the middle button in the top-left corner of 
the window to put it in the Dock. Click the window’s icon in the Dock to open it again.

To Learn More

For instructions on how to customize your Mac OS X environment and for more information 
about using Mac OS X, see the Welcome to Mac OS X book that came with your computer.
 Getting Started With Your Computer 23



Sherlock—Your Internet Search Detective

Search button

After you type what 
you are looking for, 
click this button to 
start the search.

Sherlock 
channels

Use the yellow  
pages channel to 

search for businesses 
in your location.

Directions

Sherlock displays 
driving directions 
and maps to the 

business you choose.
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What You Can Do

Sherlock is your search detective and personal shopper on the Internet. It provides an easy 
way to find people, news, and just about anything. Shop for books and music, search auction 
sites, find the best prices—even check product availability. Use the Movie channel to search 
for movies in your local theaters, watch movie trailers, and buy tickets.

To Get Started

1 Connect to the Internet.

2 Open Sherlock by clicking the Sherlock icon in the Dock. 

3 Select a Sherlock channel.

4 Type what you are looking for and click the Search button.

Tips and Tricks

Add locations in Sherlock Preferences

Some information in the channels may change based on the location you are searching from. 
To add a location to Sherlock:

1 Choose Preferences from the Sherlock menu.

2 Click Add and give the new location a name and address.

To Learn More

To learn more about what you can do with Sherlock, open Mac Help and search for 
“Sherlock.” To download additional search plug-ins and find out how you can create your 
own Sherlock plug-in, go to the Sherlock website at www.apple.com/sherlock 

Note:  Sherlock’s Yellow Pages channel may be known by a different term outside the 
United States.
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.Mac—Internet Services for Mac Users

Email
Get your own Mac.com email address. 
It’s easy, and it works with your favorite 
email programs. 

iDisk
Your own storage on Apple’s Internet 
server. Share photos, movies, and other 
files over the Internet. Purchase additional 
storage space.

HomePage
Build a personal website in three easy 
steps. Create a photo album, publish an 
iMovie, post your résumé, and more. 
Now anyone can view your page on the 
Internet.

iCards
Send an elegant iCard just right for any 
occasion. Choose a ready-made photo  
or create a personalized iCard using 
photos on your iDisk.
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What You Can Do

.Mac is a suite of Internet services from Apple created exclusively for Mac users. With .Mac, 
you can send email or greeting cards to your friends, make the Internet safer for your 
children, and share photos and movies. You can even create your own website.

To Get Started

1 Connect to the Internet.

2 Go to www.apple.com

3 Click the .Mac tab and then click the Sign Up button. 

Tips and Tricks

Upload pictures to your iDisk to create custom iCards

You can send iCards with your own custom pictures. Save your images as GIF or JPEG files 
and then copy them to the Pictures folder on your iDisk. Your images will appear as picture 
choices when you create an iCard in the Create Your Own section.

Start with a HomePage template to create your own web page in minutes

HomePage has web page templates that you can modify with your own text and images. For 
example, teachers can use the HomePage education templates to post recent class news, 
homework assignments, and other information for parents. You can also use the HomePage 
photo album and iMovie templates to share your pictures and movies easily with your friends 
and family.

Create an alias of your iDisk for easy access

Instead of using a web browser to open your iDisk, choose iDisk from the Go menu. You can 
also add an iDisk icon to the Finder toolbar. Choose Customize Toolbar from the View menu, 
then drag the iDisk icon to the Finder toolbar and click Done.

Use .Mac to control access by other users

Set up your computer so that each member of the family can log in. See “Multiple Users—
One Mac for Many Users” on page 40 for information about setting up your computer for 
several users. 
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Apple.com—Your Starting Place on the World Wide Web

Apple Software 
www.apple.com/software

Search by category for Apple 
software for your Mac.

The Apple Store
store.apple.com

Purchase the latest 
Apple hardware, software, 

and accessories.

 Macintosh
 Products Guide
www.apple.com/guide

For great hardware and software 
products for your Mac, check 
this website or look for 
the Mac symbol.
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Apple Hot News 
www.apple.com/hotnews

Find information on the latest 
software updates for your Mac, 
third-party software, QuickTime 
Hot Picks, and information on 
the next big Apple event.

Apple Support 
www.apple.com/support

Find information about the 
AppleCare Protection Plan, 

training programs, and other 
product support. Also access 

software updates, the 
Apple Knowledge Base, and 

technical information.

Mac OS X 
www.apple.com/macosx

Get the latest on the world’s most 
advanced operating system.
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QuickTime—Audio and Video on the Internet

Volume control

QuickTime 
Content Guide

Click the button  
to view the 
QuickTime topics 
you can access. 
Click a topic on 
the left and then 
click the window 
on the right.

QuickTime 
Channels

Click Hot Picks 
and then click the 

movie screen.
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What You Can Do

In addition to playing video and music files on your Mac, with QuickTime you can watch live 
and recorded Internet broadcasts.

To Get Started

1 Connect to the Internet.

2 Open QuickTime Player by clicking the QuickTime Player icon in the Dock. You can also 
double-click QuickTime Player in the Applications folder.

3 Click the QuickTime button and select a channel to get the latest video, music, and 
information over the Internet without having to store files on your hard disk.

You can add QuickTime movies to your QuickTime Favorites by choosing Add Movie As 
Favorite from the Favorites menu.

Tips and Tricks

Upgrade to QuickTime Pro to do the following:

m Play back full-screen video and resize movies.

m Create streaming movies.

m Work with more than 30 audio, video, and image formats, including Flash.

m Create, open, edit, and save movies and audio as easily as copying and pasting.

To Learn More

Internet video is just one of the things you can do with QuickTime. To learn more, start with 
QuickTime Help. To download additional channels or find information on setting up your 
own Internet streaming server, go to the QuickTime website at 
www.apple.com/quicktime
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iPhoto—Import, Organize, Share, and Edit Your Digital Pictures

New album

Organize your 
photos into  

digital albums for 
easy retrieval.

Slide show

Watch your 
photographs  

in a full screen 
slideshow with 

your favorite 
music.

Import

Import digital photos into 
iPhoto directly from your 

digital camera.

Organize

Arrange your 
photos by date, 
title, or keyword.

Share

Print photos on your  
ink jet printer. Order 
prints online. Create 
and present an 
onscreen slideshow.

Edit

Crop or rotate 
photos. Remove 
red-eye or convert 
them to black  
and white.
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What You Can Do

iPhoto lets you import pictures from your digital camera, organize them into albums, edit 
and enhance them, and share them in a number of different ways. Once you see what iPhoto 
can do with digital pictures, you may never go back to using a film camera again.

To Get Started

Plug your camera into the USB port on your Macintosh. iPhoto opens, imports your photos, 
and displays them on your screen. 

Tips and Tricks

Resize thumbnails

Drag the size control in the iPhoto window, and your photo thumbnails grow or shrink for 
easier viewing. You can view individual shots in greater detail, see hundreds of thumbnails at 
once, or quickly scroll through your photos to find the one you’re looking for.

Create albums for your favorite photos

iPhoto lets you easily organize your photographs into digital albums—birthday, vacation, 
wedding, whatever—for easy retrieval. (If you’re familiar with iTunes, think playlists for 
pictures.) Sharing and enjoying them is easy, too:  click a button to see them in a full-screen 
slideshow, accompanied by your favorite music. Email them to friends. Print them on your 
ink jet printer. Or order prints over the Internet.

Create your own books

Create custom books with your own pictures and words. It’s easy to create an album and 
select a book theme and a layout you like. Add titles and text to tell your story or describe 
your pictures. Print your book pages on your printer. iPhoto makes it simple to turn your 
book into a beautiful keepsake.

Built exclusively for Mac OS X

Harnessing the power of the world’s most advanced operating system, Mac OS X, iPhoto lets 
you manipulate high-resolution images quickly. Built-in color management ensures 
consistent color from photo to web to print. And convenient Internet tools and services 
make it easy to share your photos with others.

To Learn More

For more information on using iPhoto, see iPhoto Help or go to the iPhoto website at 
www.apple.com/iphoto
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iMovie—Create and Edit Your Own Digital Movies

iMovie monitor

Preview your 
movie or view 

video directly from 
a connected DV 

camcorder.

Playback controls

Use these to play the 
movie in the iMovie 
monitor.

Mode switch

Use this to
switch between 
importing from

a camcorder
and editing.

Timeline 
viewer

The clip viewer 
and the timeline 

viewer are 
visual aids for 

assembling and 
editing your 

movie.

Editing 
buttons

Click these to 
open panels for 
adjusting and     
selecting sounds, 
video effects,  
titles (text), and 
transitions. Click 
the Clips button to 
see the shelf. 

Scrubber bar

Use this to select  
sections of video.  

Audio tracks

Lets you work with 
recordings, music, and 
sound effects.

Playhead

Represents the 
location of the frame 
showing in the iMovie 
monitor. Move the 
playhead to see 
where things appear 
in a movie.

Video track

Lets you work 
with audio 

contained in
video clips.

Clip viewer
 

Shelf

To make clips part 
of your movie after 
you import them, 
drag them from 
the shelf to the 
clip viewer. 
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What You Can Do

iMovie is an easy-to-use digital video editing software application. With iMovie and a digital 
video camcorder, you can create and edit your own movies. Import video from the camera; 
edit clips; and add transitions, titles, sound effects, and music. Then copy the movie to a 
camcorder tape or create a QuickTime movie. You can even share your QuickTime movies by 
placing them on the web on your Apple iDisk or HomePage. 

Your computer comes with iMovie for Mac OS X and Mac OS 9.

To Get Started

1 Shoot your video, then connect the camera to your computer’s FireWire port.

2 Open iMovie in the iMovie folder (located in the Applications folder).

3 Click the Import button to import movie clips to the shelf, then add them to your movie by 
dragging them to the clip viewer.

4 Assemble and edit your movie in the clip viewer and timeline viewer.

5 Add transitions, titles, sound, and music.

6 When you are finished, choose Export from the File menu.

Tips and Tricks

Share your desktop iMovie with your friends and family

Export your movie as a QuickTime web movie and copy the movie to your iDisk. Then 
use HomePage to create your own iMovie theater so that others can view your movie on 
the Internet.

To Learn More

For more information on using iMovie, see the iMovie Tutorial or iMovie Help. For the 
latest on iMovie, including iMovie updates, additional plug-ins, and a list of compatible 
DV camcorders, go to the iMovie website at www.apple.com/imovie 
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iTunes—Digital Music for Your Mac

Eject CD 
button

Library

Your collection of 
songs, imported 

from your own audio 
CDs or downloaded 

from the Internet. 
Easily browse or 

search for music.

iPod

Sync with your iPod 
and automatically 

 update songs 
 and playlists.

Radio Tuner

Choose from 
hundreds 

of Internet radio 
stations—jazz, rock, 

talk, and more.

Search

Type some text and 
iTunes lists songs 
that match.

Playlists

Make personalized 
playlists using 
songs from your 
Library. Arrange 
your music by 
mood, artist,  
genre, or  
however you like.

Visuals button

Have iTunes display a stunning  
light show that changes, throbs,  
and pulses to the beat of your 
music. Enjoy different colors  
and patterns every time you  
listen to a song.

Equalizer

Adjust the sound 
 to your tastes using 

the 10-band EQ.

Audio CDs

Play an audio CD on your 
computer. Import songs to 
your library to play them 
without the CD.
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What You Can Do

iTunes lets you import songs from music CDs as MP3 files, create playlists, move music to 
your iPod portable MP3 player, and listen to hundreds of radio stations on the Internet. 

To Get Started

1 Open iTunes (located in the Applications folder on your hard disk).

2 Insert a music CD into your optical drive.

3 Click the checkbox next to the songs you want to import.

4 Click the Import button. Your songs are converted into MP3 files and stored in your iTunes 
library.

Tips and Tricks

Create playlists for your favorite sets of songs

iTunes lets you create playlists from songs in your library. A playlist is a list of songs in a 
specific order. Use your playlists to program your music for specific moods, artists, or 
themes. Click the New Playlist button and drag songs from your library to the playlist.

Resize the iTunes window or access iTunes from the Control Strip

You can collapse the iTunes window to show just the playback controls and status. Click the 
zoom button, the right-most button in the upper-left corner. You can also access iTunes 
controls from the Dock in Mac OS X or the iTunes Control Strip module in Mac OS 9.

Look up CD information from the CDDB

iTunes automatically connects to the CD database (CDDB) on the Internet to look up the 
name of the album, song titles, and other information about your music CD. If you are
not connected to the Internet, you can look up information on songs you imported 
the next time you connect. Select the song and choose Get CD Track Names from the 
Advanced menu.

To Learn More

For more information on using iTunes, see iTunes Help or go to the iTunes website at 
www.apple.com/itunes
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Software Update—Keep Your Mac on the Cutting Edge

Check Now

Click to check instantly for 
updates available for your Apple 

software. Select the Apple 
software you want to update 

from the list that appears.

Update software

Set how often your computer 
checks for software updates  
from Apple.
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What You Can Do

Use Software Update to automatically download and install the latest system software 
updates, drivers, and other enhancements from Apple. Use Software Update to instantly 
check Apple’s Internet servers to see if any updates are available for your Apple software. You 
can even set your Mac to check the Apple server periodically and download and install 
updated software for you.

To Get Started

1 Connect to the Internet.

2 Open System Preferences and click Software Update. 

3 Click Update Now, then select the software updates you want and click Install.

Tips and Tricks

Adjust your Software Update schedule

If you have an Internet connection that is always on, you can set a schedule for your 
computer so that it checks for software updates at a certain time on specific days of the 
week. If you have a dialup connection and you are not connected, Software Update will 
check the next time you connect.

To Learn More

For more information on using Software Update, search for “Software Update” in 
Mac Help. For the latest information on the Mac OS, go to the Mac OS website at 
www.apple.com/macos 
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Multiple Users—One Mac for Many Users

Accounts

Use the Accounts pane 
in System Preferences to 
add user accounts.

Shared folder

To give access to the 
Shared folder, a user can 

turn on file sharing in 
Sharing preferences.

Home

Each user has a home. 
Finder, Dock, Mail, and 
other preferences are  

kept for each user in the 
user’s home, so users can 

customize Mac OS X  
the way they want.
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What You Can Do

Several people can share a single computer by logging in to their individual user accounts. 
Users can select their own customized settings, such as bookmarks and desktop views, and 
access a private storage space, called “Home.” Users sharing the computer also have access 
to a common Shared folder.

The first user account created on your computer is designated an administrator. 
Administrators are users with special privileges:  they can give new users access to the 
computer, install software, and change general computer settings. 

Note:  If you forget the administrator password, you can reset it using the Mac OS X CD. 
Start up from the Mac OS X CD and choose Reset Password from the Installer menu. Because 
a user with the Mac OS X CD can gain unrestricted access to the computer, you should keep 
the CD in a safe place.

To Get Started

1 Create a new user by choosing System Preferences from the Apple (K) menu, clicking 
Accounts, then clicking New User.

2 Edit the user’s information. You can give a user administrative privileges.

3 Close the window.

Tips and Tricks

Keeping your computer secure

You can require a password to access the computer after the screen saver appears in case 
users log in and leave the computer unattended. Open System Preferences, click Screen 
Effects, and click Activation to select the period of inactivity before the screen saver starts. 
Then select “Use my user account password.” 

Set up user privileges

In Mac OS X, administrators can specify the documents and applications that users can 
access and configure overall settings. Open System Preferences, click Accounts, and 
click Capabilities.

To Learn More

For more information on setting up user accounts in Mac OS X, search for “users” in 
Mac Help. 
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Mac Help—Answers to Your Macintosh Questions

Search

Type your question 
here and press the 

Return key.

Help Center

Click here to see 
the help available 

on your computer.

Search results

Topics are 
displayed in order 
of relevance.

Help drawer

Available Help is 
displayed in the drawer.

Topic summary

Find out more about a help 
topic before viewing it.
42 Chapter  2  



C H A P T E R

3

3 Working With Your Operating System

An operating system, or OS, is your computer’s desktop environment that defines how the 
items on your desktop are represented and how you interact with them. Each OS has a 
different look and feel. 

About Mac OS X

Your computer is set to start up in Mac OS X so you can use its advanced technologies, such 
as the elegant new user interface, incredible graphics capabilities, and added system stability 
and performance. Mac OS X takes care of managing your computer processes so you can 
concentrate on what you want to do. You don’t need to worry about restarting your 
computer if something goes wrong with one software application. Mac OS X shuts down just 
that application so you can keep working without interruption. The Mac OS X virtual 
memory manager takes care of allotting the amount of memory your software applications 
need to run efficiently.

When you’re ready to learn more about Mac OS X, read the Welcome to Mac OS X book that 
came with your computer. Welcome to Mac OS X introduces the features of Mac OS X and 
provides tips for Mac OS 9 users on how to use Mac OS X to perform common Mac OS 9 
tasks. If you experience any problems while learning about Mac OS X, see the 
troubleshooting tips in the back of the Welcome to Mac OS X book or choose Mac Help from 
the Help menu in Mac OS X. 

Information About Software and Mac OS X

For information about the compatibility of software applications with Mac OS X, or to read 
more about Mac OS X, check the Apple website:  guide.apple.com/macosx/

Important   Because Mac OS X is already installed on your computer, you don’t need to 
follow the installation instructions in Welcome to Mac OS X. Instead, follow the instructions 
in Welcome to Mac OS X to log in and begin using Mac OS X.
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Using Classic in Mac OS X

In addition to using Mac OS X applications, you can continue to use Mac OS 9 applications in 
the Classic environment. Classic works in the background to access Mac OS 9 features and 
software applications. When you start up Classic, Mac OS 9 software works in Mac OS X just 
as it does in Mac OS 9, although it doesn’t benefit from Mac OS X features such as the look of 
the new interface. Simply open a Mac OS 9 application or double-click a document created in 
a Mac OS 9 application. If Classic isn’t running, it starts up.

After the Classic environment starts up, it continues to run in the background, even if you 
quit all Mac OS 9 applications, so Classic applications and documents open faster the next 
time. You can set your computer to start up Classic automatically when you log in to 
Mac OS X. Choose System Preferences from the Apple (K) menu, click Classic, and select 
“Start Classic when you log in.”

To quit the Classic environment, click Stop in the Classic pane of System Preferences. You can 
save any unsaved changes to your Classic documents and quit Classic.

Switching Between Operating Systems

Some tasks and software applications have not yet been optimized to work with Mac OS X or 
Classic and perform best in Mac OS 9. You can set your computer to start up in Mac OS 9 and 
change the Mac OS your computer uses when it starts up as often as you like.

To set your computer to start up in Mac OS 9 instead of Mac OS X: 

1 In Mac OS X, choose System Preferences from the Apple (K) menu and click Startup Disk. 

Important  Do not remove the Mac OS 9 operating system from your computer. For Classic 
to work, Mac OS 9 must be installed.
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2 Select the Mac OS 9 folder as your startup System Folder. (If the icons are dimmed, click the 
lock icon at the bottom of the pane and type the administrator user name and password that 
you created in the Setup Assistant. See Welcome to Mac OS X for more information about 
logging in as an administrator.) 

3 Restart your computer.

Note:  Because Apple frequently releases new versions and updates to its system software, 
the version number of the Mac OS X and Mac OS 9 operating systems in this manual may be 
different from those installed on your computer.

To set your computer to start up in Mac OS X instead of Mac OS 9: 

1 In Mac OS 9, choose Control Panels from the Apple (K) menu, then choose Startup Disk.

2 In the Startup Disk control panel, double-click the hard disk that contains your operating 
systems and select the Mac OS X System folder as your startup disk. You can click the triangle 
to the left of the hard disk icon to see the System folders installed on it.

3 Restart your computer.

Note:  Because Apple frequently releases new versions and updates to its system software, 
the version number of the Mac OS X and Mac OS 9 operating systems in this manual may be 
different from those installed on your computer.

Need Help?

For more information about the features of your Macintosh, choose Mac Help from the Help 
menu and click any of the blue underlined text. You can also type a question in the Search 
field and press Return on the keyboard. 
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4 Using Your Computer

This chapter provides explanations and instructions for using the important features of your 
Power Mac G4 computer, including your keyboard and mouse, modem, FireWire ports, USB 
ports, and networking. 

Explanations are provided for

m “Using Your Apple Pro Keyboard and Apple Pro Mouse” on page 48

m “Connecting a Second Display to Your Computer” on page 50

m “Using USB Devices” on page 51

m “Using FireWire Devices” on page 53

m “Using Your Optical Drive” on page 55

m “Using Your Modem” on page 57

m “Connecting to an Ethernet Network” on page 58

m “Using AirPort Wireless Networking” on page 60

m “Putting the Computer to Sleep to Save Energy” on page 62

m “Attaching SCSI Devices to Your Computer” on page 63

m “Transferring Information Between Two Macintosh Computers” on page 63

m “Using the Computer as a Server Without a Monitor” on page 64
 47



Using Your Apple Pro Keyboard and Apple Pro Mouse

Your Apple Pro Keyboard comes with function keys preset for common tasks. Use the Media 
Eject key to eject optical discs. Press the Volume Up or Volume Down keys to adjust the 
sound level, or press the Mute key to turn sound off. You can also adjust an Apple display’s 
level of brightness with the Brightness Up and Brightness Down keys.

Note:  If you’re using a non-Apple keyboard with your computer, use the F12 key to eject 
optical discs.

Customizing Function Keys (Mac OS 9)

In Mac OS 9, you can set unassigned function keys (F7–F12) on your Apple Pro Keyboard to 
open applications such as your Web browser, email program, or frequently used documents. 
Once applications are open, you can use the customized function keys to switch quickly 
between them.

The first time you press an unassigned function key, a dialog box appears that lets you assign 
any of the function keys to an application or document. You can change the application 
assigned to a function key using the Keyboard control panel.

Note:  You can’t customize function keys in Mac OS X.

Function keys

Volume Down key

Volume Up key-

Brightness Down key

Brightness Up key

Mute key—

Media Eject key
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Using Your Apple Pro Mouse

To position the pointer using your mouse, move the mouse over any suitable surface such as 
your desktop, mouse pad, or other textured surface. (Some smooth, glassy surfaces provide 
less pointer control than others.) To click an object, press down once on the mouse body 
until you feel a click. To double-click an item, press down twice in quick succession. 

You can adjust the feel of your mouse by turning the dial underneath. Turning the dial one 
direction makes the feel of clicking the mouse stiffer; turning it the other way makes clicking 
the mouse easier. 

For More Information About Your Keyboard and Mouse

Additional information on configuring the keyboard controls and customizable function 
keys is available in Mac Help. Choose Mac Help from the Help menu and search for 
“keyboard” or “mouse.”

If you run out of room and want to
keep the mouse clicked while you
lift it, click the mouse, then squeeze
the sides with your thumb and
fingers as you lift.

Turn the ring on the bottom of the mouse to “+” for more
tension, “O” for medium tension, and “–” for less tension.
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Connecting a Second Display to Your Computer

You can connect two displays to your graphics card and use both displays at the same time. 

When a second display is connected, you can either have the same image appear on both 
displays (known as mirroring) or use the second display to extend the size of the Mac OS 
desktop (known as extended desktop mode). You need a video cable for each display you 
want to connect. 

To use multiple displays:

1 Turn off the displays and shut down your computer.

2 Connect the video cable from each display to the appropriate port on the graphics card.

3 Turn on the displays and start up your computer.

To adjust the displays, choose System Preferences from the Apple menu and click Displays. 

By default, your computer starts up in extended desktop mode. To work in video mirroring 
mode, choose Video Mirroring from the Displays status menu in the menu bar in Mac OS X. 

For More Information on Displays

For information about connecting your display, see the setup instructions in Chapter 1, 
“Setting Up.”

Additional information on using and configuring an external display is available in Mac Help. 
Choose Mac Help from the Help menu and search for “display.” 

Important  For optimal mirroring performance, set both displays to the same resolution 
and color depth. 
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Using USB Devices

Your Power Mac G4 comes with two USB ports on the rear panel, and your Apple Pro 
Keyboard also has two USB ports. You can use your USB ports to connect many types of 
external devices, including printers, digital cameras, microphones, game pads, joysticks, 
keyboards, mouse devices, and storage devices. USB makes it easy to connect external 
equipment. Once you connect the device, it is ready to use. You don’t need to restart 
your computer.

To use a USB device with your computer, connect the device to the computer and install its 
software or configure your computer to work with the device. From then on, your computer 
automatically loads the correct software whenever you attach the device. 

Note:  Apple has already included software to work with many USB devices. In most cases 
you do not need to install the software that came with the device. If, when you connect a 
USB device, your Power Mac G4 cannot find the correct software, it asks you to search the 
Internet to find it.

USB ports (2)
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Connecting Multiple USB Devices

Your Power Mac G4 has two USB ports on the rear panel. Your keyboard or monitor may also 
have an available USB port that you can use to connect devices. If you want to connect more 
devices, purchase a USB hub. The USB hub connects to an open port on your computer and 
provides additional USB ports (usually four or seven). 

For More Information on USB

Additional information on USB is available in Mac Help. Choose Mac Help from the Help 
menu and search for “USB.” You can also find information on Apple’s USB website at 
www.apple.com/usb 

For information on USB devices available for your computer, go to the Macintosh Products 
Guide at www.apple.com/guide 

USB hub
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Using FireWire Devices

Your computer has two FireWire ports. FireWire is a high-speed data transfer system that lets 
you easily connect and disconnect external devices—such as digital video (DV ) cameras, 
printers, scanners, and hard disks. You can connect and disconnect FireWire devices without 
restarting your computer. 

These are some of the things you can do with FireWire:

m Connect a digital video camera and capture or transfer high-quality video directly to 
your computer. Then you can use video-editing software such as Apple’s iMovie to edit 
the video. 

m Connect an external FireWire hard disk drive and use it to back up data or transfer 
files. If you have installed software for your FireWire hard disk, the FireWire disk icon 
appears on your desktop after you connect the disk drive to your Power Mac G4. Some 
FireWire hard disks get their power through the FireWire cable, so you don’t need to 
connect an external power supply.

m If you have a problem with your computer that prevents you from starting up or you want 
to transfer files, you can use FireWire to connect your Power Mac G4 to another computer 
so that your Power Mac G4 appears as an external hard disk on the other computer (a 
feature known as FireWire target disk mode). See “FireWire Target Disk Mode” on page 54 
for more information.

To use a FireWire device with your computer, connect the device to the computer and install 
any software that came with the device. Your computer automatically detects when you 
attach a new device. 

To start up from a FireWire hard disk that has the Mac OS on it, choose System Preferences 
from the Apple (K) menu, click Startup Disk, then select the FireWire hard disk as the 
startup disk. 

If your FireWire hard disk doesn’t appear or can’t be selected, consult the FireWire hard disk 
vendor for updated software drivers.

To disconnect your FireWire hard disk safely, drag its icon to the Trash before disconnecting 
the FireWire cable.

FireWire ports (2)
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FireWire Target Disk Mode

You can use FireWire to connect your Power Mac G4 to another computer and then have it 
appear as an external hard disk on that computer. You can then share or transfer files.  

To connect your Power Mac G4 in FireWire target disk mode, follow these steps:

1 Shut down your Power Mac G4. 

2 Use a FireWire cable with a 6-pin connector on each end to connect your computer to 
another FireWire-equipped computer.

3 Start up your Power Mac G4 and immediately hold down the T key.

Your Power Mac G4 display shows the FireWire disk mode indicator, and the Power Mac G4 
internal hard disk icon appears on the desktop of the other computer.

4 When you are finished transferring files, drag the Power Mac G4 hard disk icon to the Trash 
to unmount the drive.

5 Press the power button on the Power Mac G4 to shut it down and then disconnect the 
FireWire cable.

For More Information on FireWire

Additional information on FireWire, including setting up a network of FireWire devices, is 
available in Mac Help. Choose Mac Help from the Help menu, and search for “FireWire.” 
You can also find information on Apple’s FireWire website at www.apple.com/firewire 

For information on the FireWire devices available for your computer, go to the Macintosh 
Products Guide at www.apple.com/guide 

Important  The computer you connect your Power Mac G4 to must have FireWire version 
2.3.3 or later installed. Use Apple System Profiler (located in the Utilities folder, in your 
computer’s Applications folder) to check the version of FireWire installed. If you have an 
older version, check for an update at the Apple FireWire website at www.apple.com/firewire 
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Using Your Optical Drive

You can install or run software from CDs using your optical drive. You can play multimedia on 
CD discs and music from audio CDs. Your optical drive can also write music, documents, and 
other digital files on CD-R and CD-RW discs. If you have a DVD-ROM/CD-RW drive, you can 
also play DVD movies and use most DVD discs. 

If you have older software that comes on floppy disks, contact the software manufacturer to 
see if the software is available on a CD or purchase an external USB floppy disk drive for your 
Power Mac G4 from your Apple dealer or the Apple Store (www.apple.com/store).

Inserting a Disc

To install or use programs from a CD or DVD, follow these steps:

1 With the computer turned on, press the Media Eject (C) key on your Apple Pro Keyboard to 
open the drive.

2 Place a disc in the tray, with the label facing up, and make sure the disc is lying flat.

3 Gently push the tray in to close it. 

When the icon for the disc appears on the screen, the disc is ready to use.

Ejecting a Disc

You can eject a disc by dragging the disc icon to the Trash, or by pressing the Media Eject (C) 
key on your Apple Pro Keyboard. You can also eject a disc by holding down the mouse button 
while restarting your computer.

Adjusting the Sound While Playing DVD and Audio Discs

Repeatedly press the volume keys (-, –) on your keyboard to adjust speaker volume. You 
can also adjust speaker volume and balance from your computer by choosing System 
Preferences from the Apple (K) menu and clicking Sound. 

When you attach Apple Pro speakers or headphones to your computer, the internal speaker 
does not output sound.
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Recording Information on a CD

Your drive can record your favorite music, programs, and files on CD-R and CD-RW discs. 
You can create your own music CDs and play them on any standard audio player. You can 
also record computer files, such as applications, documents, or other digital files, on a 
recordable CD. 

With a CD-R (CD-Recordable) disc, you can record information on the disc once. Although 
you can’t change the recorded information, you may be able to add more information until 
the disc is full, depending on the application you use. See the documentation that came 
with your application for specific information about recording on your CD-R disc. It is best 
to use CD-R discs for recording audio CDs, because most audio CD players cannot read 
CD-RW discs.

With a CD-RW (CD-Rewritable) disc, you can save and change information on your CD 
multiple times. However, some software for recording media files on CDs, such as the iTunes 
Disc Burner feature, can record data on the disc only once.

You can record music on CD-R discs right from iTunes.

1 Open iTunes by clicking its icon in the Dock in Mac OS X.

2 Select the playlist you want to record.

3 Insert a blank CD-R disc.

4 Click Burn CD at the top of the iTunes window.

You can also record data on CD-R discs with Disc Burner.

1 Insert a blank disc in the optical drive.

2 In the dialog box that appears, enter a name for the disc and select the format you want to 
create. An icon for the CD appears on the desktop.

3 Double-click the CD icon, then drag files and folders to it.

4 Choose Burn Disc from the File menu or select the disc and drag it to the Burn Disc icon in 
the Dock in Mac OS X.

For information about how to use iTunes to record music files on a CD, see iTunes Help, 
available in the Help menu when iTunes is open.
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Using Your Modem

Your Macintosh may come with an Apple 56K internal modem installed. 

To connect the Apple 56K internal modem, plug one end of the modem cord or RJ-11 cable 
into the modem port on the back of the computer and the other end into a standard RJ-11 
telephone wall jack.

 

Connecting to the Internet Via a Service Provider

Before you can connect to the Internet using your modem, you must record your service 
provider information in the Network pane of Mac OS X System Preferences. When you first 
start up your computer, the Setup Assistant guides you through recording these settings. To 
record or change these settings later, do the following:

1 Choose System Preferences from the Apple (K) menu and click the Network icon.

2 Click the PPP tab and enter information about your service provider account.

3 Click the Modem tab, choose the modem settings you want, and click Apply Now.

4 Close System Preferences.

Your computer is now set up to connect with your service provider. You don’t need to enter 
these settings again.

To establish a connection with your service provider:

m Open the Internet Connect application in your Applications folder and click Connect.

More information about the internal modem is available in Mac Help.

Using an External USB Modem

To connect an external USB modem, use a USB cable to connect the modem to an available 
USB port on the keyboard, computer, USB monitor, or USB hub.

Modem port

Modem port icon

Important  Make sure you connect the internal modem to an analog phone line—the kind 
used typically in homes. The modem will not work with a digital phone line.

Warning  Disconnect your modem from the phone jack during lightning or thunder 
storms. This will prevent a voltage overload from damaging the modem.
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Check the documentation that came with the modem to see if it needs to be plugged into a 
power outlet. Also look for instructions about installing modem software and connecting the 
modem to a telephone line.

Connecting to an Ethernet Network

Your computer comes with built-in 10/100/1000 megabit per second (Mbps) twisted-pair 
Ethernet networking capability. Connecting to a network gives you access to other 
computers. You may be able to store and retrieve information; use network printers, 
modems, and electronic mail; or connect to the Internet. You can also use Ethernet to share 
files between two computers or set up a small network.

If you’re connecting to an existing network, you may be able to get information about the 
network and the network software you need from a network administrator who oversees its 
operation. Identify your organization’s network administrator before you begin.

Follow these guidelines when selecting a cable for your network:

Connecting to a Twisted-Pair Ethernet Network

You can connect directly to a 10/100/1000 twisted-pair Ethernet network.

Note:  You can also connect your computer to an Ethernet network that uses thin 
coaxial cables. To do this, you need an RJ-45–to–Thin Coax adapter (available from other 
manufacturers). See your Apple-authorized dealer for more information on Ethernet 
media adapters.

Type of twisted-pair Ethernet Use twisted-pair cable types

10 Mbps Category 3, 5, or 6

100/1000 Mbps Category 5 or 6
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To connect your Macintosh to a centralized 10/100/1000 twisted-pair Ethernet network, 
follow these steps:

1 Plug one end of an RJ-45 twisted-pair cable into the Ethernet port on your Macintosh.

2 Plug the other end of the cord into an RJ-45 wall outlet or external hub that is connected to a 
twisted-pair Ethernet network.

After you start up the computer, you need to configure the software for your network 
connection. Your network administrator can provide the necessary information. You can also 
get help configuring your network software using Mac Help (in the Help menu).

To configure your network settings:

1 Choose System Preferences from the Apple (K) menu and click Network.

2 Choose Built-in Ethernet from the Show pop-up menu. 

3 Click the TCP/IP tab and enter information about your network. The default setting is 
Configure Using DHCP.

4 Click Apply Now.

5 Close System Preferences.

Ethernet port
(Twisted-pair
Ethernet)

RJ-45 wall plate

Twisted-pair Ethernet cable

Ethernet hub
or switch
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Maximizing Ethernet Performance

Your computer performs best when the Ethernet port to which it is connected is set to 
auto-negotiate. Ask your network administrator to verify this setting. 

Note:  If you connect your computer directly to a configurable Ethernet switch, have your 
network administrator disable spanning tree on that port. Otherwise your computer may 
duplicate the AppleTalk address of another computer on the same network and both 
network connections may become unreliable.

For more information on networking your Power Mac G4, go to AppleCare Service and 
Support at www.apple.com/support 

For More Information on Using Ethernet

Additional information, including setting up an Ethernet network or transferring files using 
Ethernet, is available in Mac Help. Choose Mac Help from the Help menu and search for 
“Ethernet” or “network.” 

For information on networking products you can use with your Power Mac G4, go to the 
Macintosh Products Guide at www.apple.com/guide

Using AirPort Wireless Networking

AirPort offers an easy and affordable way to provide wireless Internet access anywhere in the 
home, at work, or in the classroom. Instead of using traditional cables, AirPort uses wireless 
local area network (LAN) technology to provide wireless communication between multiple 
computers. Through a wireless network you can set up access to the Internet, transfer files, 
play multiplayer games, and more.

Your Power Mac G4 is AirPort-ready. The only thing you need to add is an AirPort Card. See 
“Installing an AirPort Card” on page 82. You install the AirPort Card in a slot inside the 
computer and connect it directly to the end of a built-in antenna cable. For instructions on 
using your Airport Card, see the About Your Airport Card booklet that came with your card.

Important  If you experience connection problems on your network, make sure your 
network switch is set to auto-negotiate, if possible. If a switch’s port is not auto-negotiating, 
your computer detects the appropriate speed but defaults to half-duplex mode. If the 
switch’s port at the other end of the link is configured for full-duplex, a large number of late 
events can occur on the link. If it isn’t possible to set the switch to auto-negotiate, then set 
the switch’s port to half-duplex. For more information, see the documentation that came 
with the Ethernet switch.
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How AirPort Provides Wireless Internet Access

With AirPort, you set up a wireless connection to a device known as a base station, which has 
a physical connection to the Internet. AirPort technology works like a cordless telephone. 
The handset of the cordless phone makes a wireless connection to the base, which is 
connected to the telephone line. Similarly, your computer makes a wireless connection to 
the base station, which is connected to the telephone line or your Ethernet network. 

Wireless Network Connections

If you install an AirPort Card, you can

m connect your computer to a computer network that has wireless access

m use your computer to provide network access for other computers using wireless cards

m establish a wireless connection and share information with another computer that has an 
AirPort Card

Check with your network administrator for more information about reaching the network’s 
wireless access point. 

AirPort Base Station

Telephone or Ethernet connection

Warning  Several kinds of objects placed near the computer can cause interference. See 
the instructions that come with an AirPort Card or AirPort Base Station to learn about 
avoiding interference. For more information, go to AppleCare Service and Support at 
www.apple.com/support
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For More Information on AirPort

To purchase an AirPort Card or AirPort Base Station, contact your Apple-authorized dealer or 
go to the Apple Store at www.apple.com/store

Additional information on AirPort is available in the online help. Choose Help Center from 
the Help menu and click AirPort Help. You can also find information in the instructions that 
came with your Airport Card or on Apple’s AirPort website at www.apple.com/airport

Putting the Computer to Sleep to Save Energy

Power Mac G4 computers are set to go to sleep after a period of inactivity. Sleep is a state in 
which your computer uses very little power. You can also put the computer to sleep 
whenever you want.

Note:  Power Mac G4 computers are set to sleep automatically after 20 minutes of inactivity; 
however, you can change the automatic sleep settings in System Preferences.

When the computer wakes from sleep, your programs, documents, and computer settings 
are exactly as you left them. To save more energy, shut down the computer or turn off the 
power strip when the computer is not in use.

To put your computer to sleep, you can do any of the following:

m Press the power button on the front of the computer.

m Choose Sleep from the Apple (K) menu.

m Set a sleep timer in your computer’s sleep settings by choosing System Preferences from 
the Apple (K) menu and clicking Energy Saver.

When the computer is in sleep, the front panel power button light pulses.

To wake the computer, press the power button on the front panel of the computer, or press a 
key on the keyboard. With some Apple monitors, you can also use the monitor’s power 
button to put the computer to sleep and wake it.

Not all PCI cards or replacement AGP cards comply with the computer’s power management 
standards. If you install a non-compliant card, the computer can still enter sleep mode, but it 
will not achieve maximum energy saving. You can use the Apple System Profiler to find out 
whether an installed card is compliant.

For more information about energy-saving options, see Mac Help.
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Attaching SCSI Devices to Your Computer

Some Power Mac G4 computer configurations come with an Ultra160 Dual Channel SCSI 
card installed in a PCI slot with one or more internal SCSI hard disks connected to it. You 
can install additional internal SCSI hard disk drives, up to a maximum of three drives. It’s 
recommended that you only connect SCSI Ultra160 LVD hard disk drives to the internal port 
of the Dual Channel SCSI card. You can connect external SCSI devices, including older drives 
with slower data transfer rates, to the external port of the Ultra160 Dual Channel SCSI card. 
Because the card has two channels, one connected to the internal port and another 
connected to the external port, connecting older devices to the external port doesn’t slow 
down the transfer rate of the internal hard disk drives. 

Apple recommends that you use only SCSI Ultra160 LVD devices as internal hard disk drives.

To connect older SCSI devices that use a 25-pin or a 50-pin connector—such as Zip drives, 
scanners, or DAT drives—you need to purchase SCSI adapters, or purchase and install a 
“legacy” SCSI PCI card (one that supports older devices).

For more information about using different types of SCSI devices with your computer, go to 
AppleCare Service and Support at www.apple.com/support

Transferring Information Between Two Macintosh 
Computers

If two Macintosh computers are not connected by a network, you can transfer information 
between them by connecting them with a standard category 5, 4 wire-pair (8 wires) Ethernet 
cable (in effect creating a small network of just two computers), which you can buy from an 
Apple-authorized dealer. You connect the cable to each computer’s Ethernet port and then 
turn on file sharing on both computers. You can also configure the Ethernet settings on two 
computers to create a small network. 

First, turn on file sharing on both computers:

1 Choose System Preferences from the Apple (K) menu.

2 Open the Sharing pane and click Start to turn File Sharing on.

3 Open the Network pane, select AppleTalk, then select “Make AppleTalk Active.” 

Next, follow these steps on one computer:

1 Choose Connect to Server from the Go menu.

2 Click Local Network.

3 Select the computer you want to access.

For more information about configuring Ethernet connections, search for “Ethernet” in 
Mac Help. 
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You can also connect two Macintosh computers using a FireWire cable. You can then use 
FireWire target disk mode to transfer files from one computer to another. For more 
information about using FireWire target disk mode, see “FireWire Target Disk Mode” on 
page 54.

If you have an Internet connection, you can also transfer files via the Internet to your iDisk 
storage area on .Mac, where you or another .Mac user can download them. For more 
information about .Mac, see “.Mac—Internet Services for Mac Users” on page 26.

Using the Computer as a Server Without a Monitor

You can set up your computer to run as a server without an attached monitor. Follow 
these steps:

1 Follow all the steps described in Chapter 1 to set up your computer, including connecting a 
monitor, mouse, and keyboard.

2 Configure your server software as follows:

m Configure network access.

m Configure the security application so that the server can be controlled remotely.

m Set passwords for access to the server.

m Set network services to start up when the system starts up.

3 Be sure network services are operating properly.

4 Disconnect the monitor.

If you’re using remote access software, follow the instructions that came with your software 
for logging in to and controlling the server.
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5 Working Inside Your Computer

This chapter provides information and instructions for working inside your computer. 

Instructions are provided for the following procedures:

m “Opening the Computer” on page 66

m “Installing Memory” on page 69

m “Installing Internal Storage Devices” on page 71

m “Installing a PCI Expansion Card or Replacing the AGP Card” on page 79

m “Installing an AirPort Card” on page 82

m “Replacing the Battery” on page 83

Warning  Apple recommends that you have an Apple-certified technician install memory, 
PCI expansion cards, and internal storage devices. Consult the service and support 
information that came with your computer for instructions on how to contact an Apple-
authorized service provider or Apple for service. If you install these items yourself, you 
risk damaging your equipment, and such damage is not covered by the limited warranty 
on your computer. See an Apple-authorized dealer or service provider for additional 
information about this or any other warranty question.
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Opening the Computer

1 To shut down your computer:

m In Mac OS X, choose Shut Down from the Apple (K) menu.

m In Mac OS 9, choose Shut Down from the Special menu.

Wait five to ten minutes to allow the computer’s internal components to cool.

2 Unplug all the cables from the computer except the power cord.

3 Touch the metal PCI access covers on the back of the computer to discharge any static charge.

Warning  Always shut down your Power Mac G4 before opening it to avoid damaging 
its internal components or the components you want to install. Do not open the 
computer or attempt to install items inside it while it is turned on. After shutting down 
your computer, the internal components can be very hot. Let the computer cool down 
before continuing. 

Touch the metal
portion of the PCI
port access covers.

Important  Always do this before you touch any parts, or install any components, inside 
the computer. To avoid generating static electricity, do not walk around the room until you 
have finished installing the expansion card, memory, or internal storage device and closed 
the computer.
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4 Unplug the power cord.

5 Lift the latch on the side of the computer. 

Note:  If the latch won’t lift, check that the security lock port and lockable cover latch in the 
back of the computer are not locked.

Warning  The power supply in your computer is a high-voltage component and should 
not be opened for any reason, even when the computer is off. If the power supply needs 
service, contact your Apple-authorized dealer or service provider.

Lift the latch to unlock
the side panel.
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6 Gently lower the side panel onto a clean, flat surface, preferably onto a soft, clean cloth.

Gently lower the side
panel until it lies flat.
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Installing Memory

You can install additional Dynamic Random-Access Memory (DRAM) in packages called 
Dual Inline Memory Modules (DIMMs) in the three DRAM DIMM slots on your computer’s 
main logic board. You can expand your computer’s DRAM to a maximum of 1536 megabytes 
(1.5 gigabytes). To check the amounts of DRAM installed, use the Apple System Profiler 
(located in the Utilities folder, in your computer’s Applications folder).

If you install 512 MB DIMMs, they must have 256 megabit (Mbit) devices. You can also install 
256 MB DIMMs that have 256 Mbit or 128 Mbit devices. You can install different size DRAM 
DIMMs in any order in any DIMM slot. To check the compatibility of your DIMMs, see the 
Macintosh Products Guide on Apple’s website:  www.apple.com/guide 

DIMMs must fit these specifications: 

m “PC-133” Synchronous DRAM (SDRAM)

m 3.3 volt ( V )

m 64-bit wide, 168-pin module

m Maximum number of memory devices on a DIMM is 16.

m Unbuffered; do not use registered or buffered SDRAM.

m Height must not exceed 2.0 inches.

Note:  When purchasing DRAM for use in Macintosh computers, make sure that the memory 
vendor conforms to the JEDEC specification. Check with your memory vendor to ensure that 
the DRAM DIMM supports the correct timing modes and that the Serial Presence Detect 
(SPD) feature has been programmed properly, as described in the JEDEC specification. You 
can purchase Apple-branded memory online from the Apple Store at store.apple.com 

Important  DIMMs from older Macintosh computers may not be compatible with your 
Power Mac G4. Only “PC-133” DIMMs are compatible. Do not use older DIMMs even if they 
fit into the DRAM DIMM slots.
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1 Open the ejectors on the DRAM DIMM slots you want to use by pushing down on them.

2 Align a DRAM DIMM in the DRAM slot as pictured. Firmly push both edges of the DIMM 
down until the ejectors snap into place.  

3 Close the computer.

Important  Do not touch the DIMM’s connectors. Handle the DIMM only by the edges.

DRAM DIMM (Your DIMM’s shape and components may vary.)

Ejector
(Your slot may have one or two ejectors.
They should be pushed outward and down
to be in the open position, as shown.) 

The DRAM DIMM is designed to fit into
the slot only one way. Be sure to align the
notches in the DIMM with the small ribs
inside the slot. With the ejectors in the
open position (as shown), push down
on the DIMM until it snaps into place.
The ejectors will automatically close. 

Connectors Notches DRAM slot (1 of 3)

Ribs (inside slot)
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Installing Internal Storage Devices

Your Macintosh has five internal drive bays. Three are in the lower part of the computer and 
two are in front on top. In many configurations, a single hard disk drive occupies a lower bay. 
One of the upper bays contains an optical drive, and you can purchase and install an optional 
Zip drive in the other upper bay. 

You can add SCSI and ATA disk drives to the empty lower drive bays.

Drives must meet these specifications:

m Width:  3.9 inches (102 mm)

m Depth:  5.7 inches (147 mm)

m Height:  1.0 inch (ATA), 1.6 inches (SCSI)

The computer provides support for the following types of internal storage devices: 

m ATA devices, including ATA, ATA-2, ATA-3, up to ATA-6 devices

m Ultra ATA devices

m Ultra ATA/66 devices

m ATAPI drives, including CD-ROM, CD-RW, DVD-ROM, DVD-R, and Zip drives

m Wide Ultra SCSI devices (requires an additional SCSI PCI card)

m Ultra2 and Ultra160 low-voltage differential (LVD) SCSI devices (requires a SCSI PCI card)

For more information about requirements and devices supported, see your Apple-authorized 
dealer and the support section of Apple’s website:  www.apple.com/support

Important  Your computer works with internal storage devices that are set for cable select 
mode. Because cable select mode forces the drive to set its ID based upon its position on the 
cable, hard disk drives and optical drives are easily configured. Before you install an 
additional device, check the documentation that came with the device or with the 
manufacturer to make sure the device is set for cable select mode.

Important  Use the original Apple cables that came with your computer when you install 
additional devices. Some non-Apple cables may not correctly support cable select mode.
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Installing Ultra ATA Drives

Your Macintosh can accommodate two internal 1-inch-high ATA devices in the U-shaped drive 
carrier in drive position 3 in the computer. If your computer has one Ultra ATA device, it sits 
in the lower portion of this U-shaped drive carrier. You can install a second ATA device in the 
upper part of the carrier.

Note:  Contact your device manufacturer or consult the manufacturer’s website to 
determine if your device is set for cable select mode. Before installation, set the device to 
cable select mode if the manufacturer hasn’t already done so.

1 Remove the power cord bundle and the ribbon cable from the device.

Unplug the power cord
bundle from the hard disk
drive. The plug is held tightly
in place, so pull firmly.

Drive position 3

Drive position 2

Unplug the ribbon cable
from the hard disk drive.

Drive position 1
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2 Remove the low-profile attachment screw from the drive carrier and tilt the carrier up to 
remove it from the computer.

Remove the attachment screw
to release the drive carrier.

Tilt the drive carrier up
and carefully pull it out

of the computer.
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3 Install the ATA device in the U-shaped bracket.

Note:  The tinted screws illustrated below indicate the four low-profile screws that come
in the computer’s accessory kit. The untinted screws show the screws that come with the 
new device.

If you’re installing a device in the lower part of the U-shaped bracket, use the low-profile 
screws to attach the bottom of the device to the carrier.

Attach an additional ATA drive (1" high)
to the upper portion of the drive carrier
by screwing it into position on its sides.
Attach the two screws on this side first.

These two
tabs will
bend 
inward as
you tighten
these two
screws.

ATA drives that are 1" high are attached
to the lower portion of the drive carrier
from the bottom.

Position the hard disk drive on the drive carrier so that the ribbon cable connector and the
power cord connector are accessible.
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4 Replace the carrier and device.

5 Reinsert the low-profile attachment screw you removed from the carrier in step 2.

Slide the hard disk drive into the
computer at an angle, and lower

it into position. Make sure the
two tabs on the underside of

the drive carrier engage the
slots on the floor of the computer.

Install the
attachment screw

to secure the drive carrier.
 Working Inside Your Computer 75



6 Reconnect the power cord bundles and the ribbon cable to the hard disk drives.

7 Close the computer. 

Plug the power cord bundles into
the hard disk drives. Be sure to
press them firmly into position.

Tuck the excess
power cord

bundle cable
around the
side of the
hard disk

drives.

Plug the end of
the ATA ribbon cable
back into the bottom

ATA drive. Plug the middle
connector into the top ATA drive.
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Installing Ultra160 LVD SCSI Drives

If your Macintosh has an internal Ultra160 LVD SCSI drive, you can connect up to two more 
internal Ultra160 LVD SCSI drives to the PCI card and cable inside the computer. This cable 
has the required connectors and a built-in terminator, so you don’t need to add one.

Note:  If your computer doesn’t have a SCSI hard disk drive, you need to install a SCSI PCI 
card in your computer to connect SCSI hard disks.

The procedures for disconnecting and connecting a SCSI hard disk drive and for removing 
and inserting drive carriers are nearly identical to those presented in the ATA drive 
installation instructions on page 72. Follow the ATA drive instructions when installing a SCSI 
drive. However, before installing your SCSI drive, note the following differences:

When you configure your SCSI hard disk drive

Assign a unique SCSI ID number to each new device. A single factory-installed drive uses 
SCSI ID 0; a second factory-installed drive uses SCSI ID 1; and a third factory-installed drive 
uses SCSI ID 2. The SCSI PCI card has been assigned ID 7. If you select one of these numbers 
for a new drive, the drive will not work properly.

When you attach the drive to the carrier

If you’re installing a SCSI drive in a computer that came with one SCSI drive, install the new 
drive in position 3 (see “Inside Your Power Mac—Your Computer’s Internal Expansion 
Options” on page 18). Do not install a SCSI drive in the top position of the U-shaped bracket.

SCSI drives that are 1.6" high are attached
to the lower portion of the drive carrier
by screwing it into position on its sides.

SCSI drives that are 1" high are
attached to the lower portion of
the drive carrier from the bottom.

Position the hard disk drive on the drive carrier so that the ribbon cable connector
and the power cord connector are accessible.
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Note:  The tinted screws in the previous illustration indicate the four low-profile screws that 
come with the computer. The untinted screws in the following illustration show the screws 
that come with the new drive.

When you replace the carrier and reconnect the drive cables

Attach additional SCSI drives (1" or 1.6" high) to the two flat drive
carriers by screwing them into position from the bottom.

Position the hard disk drive
on the drive carrier so that
the ribbon cable connector
and the power cord connector
are accessible. Screw the drive
into position with the four screws
supplied with the drive.

If your computer came with a SCSI hard disk drive installed in
drive position 1, and you are installing a SCSI hard disk drive
in drive position 2 or 3, put the ribbon cable on top of the drives.
You can tape the ribbon cable to the tops of the drives with
double-stick foam tape to make the cable lie flat.

SCSI terminator

PCI SCSI card
The ribbon cable may attach to a different position on
the PCI SCSI card, depending on the card you have. 

Make sure all of the power
cord and ribbon cable
connectors are firmly attached
to all of the drives and to the
PCI SCSI card.
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Installing a PCI Expansion Card or Replacing the AGP Card

You can expand the capabilities of your Power Mac G4 by installing cards in its expansion 
slots. The computer has five expansion card slots, four of which accommodate Peripheral 
Component Interconnect (PCI) cards and one that accepts an advanced graphics port (AGP) 
card.

AGP cards and PCI cards have different connectors, so you cannot insert a PCI card into the 
AGP slot.

About AGP Cards

Your AGP card, installed in slot 1, provides the computer’s monitor port. Slot 1 is designed 
specifically to accept AGP cards that have a 32-bit data width. This 66 megahertz (MHz) slot 
accommodates 3.3 volt ( V ) AGP cards (see the illustration on page 81).

You can replace the card that came with the computer with an AGP 1X card, 2X card, or 4X 
card. A replacement AGP card must have a driver compatible with the Mac OS.

About PCI Expansion Cards

Your Macintosh has four expansion slots, labeled 2, 3, 4, and 5, which accept PCI cards up 
to 12 inches long. Some models come with a SCSI PCI card installed in one of these slots. 
Install only expansion cards that come with Macintosh driver software and that comply with 
the PCI 2.1 standard.

The PCI slots can accommodate mixed voltage (5.0 V, 12 V, or 3.3 V ) cards with 32-bit or 
64-bit data widths and a 33 MHz frequency. You can add a 66 MHz card to a PCI slot if the 
card can operate at the lower 33 MHz rate.

Maximum power consumption for all five expansion slots (the four PCI expansion cards and 
the AGP card) should not exceed 80 watts ( W ). 

Warning  Do not use cards that function only at 66 MHz in the PCI slots. Damage to your 
equipment could result. If you have a 66 MHz card, check the card’s manufacturer to see 
if it also works at 33 MHz.
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Installing Your Card

Install an AGP card in slot 1 only. Install PCI expansion cards in the slots labeled PCI 2, 3, 4, 
and 5.

1 Remove the screw that holds the port access cover in place, pull out the access cover, and set 
it aside.

m To remove a card that’s installed in the computer, remove the screw that holds the card in 
place and pull the card from the slot.

2 Remove the card that you want to install from its static-proof bag and hold it by its corners, 
taking care not to touch the gold connector or any of the components on the card.

Port access cover

Remove the screw that
holds the port access
cover in place.

If you need to
remove the card in

the AGP slot, press this
tab to release the catch.
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3 Align the card’s connector with the expansion slot and press down until the connector is 
inserted all the way into the slot.

If you’re installing a 12-inch card, make sure the card engages the appropriate guide at the 
front of the computer.

Press the card gently but firmly until the connector is fully inserted.

m Don’t rock the card from side to side; instead, press the card straight into the slot. 

m Don’t force the card. If you meet a lot of resistance, pull the card out. Check the 
connector and the slot for damage or obstructions, then try inserting the card again.

m Pull the card gently to see if it is properly connected. If it resists and stays in place, and if 
its gold connectors are barely visible, the card is connected. 

Port access opening

PCI slot

Reinstall the screw to
secure the card in place.

If the PCI card you
are installing is full-length
(12 inches), make sure it fits
in one of these five card guides.
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4 Reinsert the port access cover screw and tighten it to hold the card in place.

5 Close the computer.

Installing an AirPort Card

1 Position the AirPort Card with the AirPort ID numbers and bar code facing up and insert the 
card into the AirPort Card connector.

2 Carefully attach the coaxial antenna wire to the port on the end of the AirPort Card. 

Warning  If you removed a card from your computer and did not install a replacement, 
be sure to place a port access cover over the empty slot. Do not leave an empty slot 
without a cover. An uncovered slot can affect the air flow that cools the computer’s 
internal components and cause damage.

Insert the AirPort Card—bar
code side up—until it is firmly
seated in the connector.

Plug the antenna wire into the
hole in the end of the AirPort Card.

The antenna wire is stowed
here when not in use.

AirPort Card connector
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The antenna wire is stowed on the side of the PCI card guide. Don’t bend or crimp the 
wire tightly.

3 Close the computer. 

Replacing the Battery

Your computer has a 3.6 V lithium battery installed on the main logic board. Some signs that 
you need to replace the battery are intermittent problems starting up the computer and 
random changes in its date and time settings. You can purchase a replacement battery from 
an Apple-authorized dealer.

1 Remove the battery from its holder, noting the orientation of the battery’s positive end. (A 
plus sign is marked on and near the battery holder.)

Important  Batteries contain chemicals, some of which may be harmful to the environment. 
Please dispose of used batteries according to your local environmental laws and guidelines.

Remove the battery by pulling it
up and out of its holder. You may
need to spread these two tabs
slightly apart to release the battery.
Spread the tabs gently so they
don’t break.
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2 Insert the new battery in the holder, making sure the battery’s positive symbol aligns with 
the positive symbol on or near the holder.

3 Close the computer.

Warning  Installing the battery incorrectly may cause an explosion. Be sure the battery’s 
positive and negative poles are correctly oriented in the holder. Use only the same type of 
battery or an equivalent recommended by the manufacturer of the original.
84 Chapter  5  



C H A P T E R

6

6 Troubleshooting 

If you have a problem while working with your computer, here are some things you can try 
right away. 

Note:  If you have problems in the Classic environment, troubleshoot them as you would in 
Mac OS 9, not Mac OS X. 

If the computer won’t respond or the pointer won’t move:

First, make sure the mouse and keyboard are connected.

m Unplug and then plug in the connectors and make sure they are firmly seated.

Then try to cancel what the computer is doing.

m Press the Command (x) and Q keys at the same time to try to quit the current 
application. 

m Press the Command (x) and period keys at the same time and, if a dialog box appears, 
click Cancel. 

m In Mac OS X, choose Force Quit from the Apple (K) menu and select the application. 
Restart the computer by choosing Restart from the Apple (K) menu to be sure the 
problem is entirely cleared up. You can also press the Esc, Option, and Command (x) 
keys at the same time.

m In Mac OS 9, hold down the Esc, Option, and Command (x) keys to force the application 
to quit. Restart the computer by choosing Restart from the Special menu to be sure the 
problem is entirely cleared up.

m If that doesn’t work, hold down the power button on the front of the computer for 
five seconds. After the computer turns off, press the button again to turn it on.

m If all else fails, unplug the power cord to turn the computer off, then replug the power 
cord and use the front panel power button to restart the computer.

m If the problem occurs only when you use a particular program, check with the 
program’s manufacturer to see if it is compatible with your computer.
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m If the problem occurs frequently, choose Mac Help from the Help menu. 

m In Mac OS X, search for “solve problems.”

m In Mac OS 9, look at the section on how to prevent and solve problems. You may also 
need to check for extension conflicts or reinstall your computer’s system software.

If the computer freezes during startup or you see a continuous flashing 
question mark for more than a minute: 

If you are starting up in Mac OS 9, turn off your Mac OS 9 system extensions.

m Start up your computer while holding down the Shift key.

m If your computer is set to start up from another computer on your network, check that 
your Ethernet cables are firmly connected, then restart your computer. Your computer 
may be having trouble connecting to the network. Check that the startup computer or 
server is not down.

m If you are in Mac OS 9, remove any items from the Servers folder in your System Folder. 
Your computer may be having trouble connecting to a server over the Internet.

If that does not work, or if you are starting up in Mac OS X, turn off the computer by holding 
down the power (®) button. Then start up using the Software Install CD. 

m Insert your system software CD and start up while holding down the C key. (Make sure 
the Caps Lock key is not engaged.)

m After the computer starts up, see the troubleshooting information in the onscreen help. 
Choose Mac Help from the Help menu. Look at the section on how to prevent and solve 
problems. You may need to check for extension conflicts or reinstall your computer’s 
system software.

If the computer won’t turn on or start up:

First, make sure the power cord is connected to a working power source.

m The plug on the power cord must be completely inserted into the computer’s power 
socket and firmly seated for your computer to operate correctly.

Reset the computer’s parameter random-access memory (PRAM).

m Start up the computer and immediately hold down the Command (x), Option, P, and R 
keys until you hear the startup sound a second time. Then set your hard disk as the 
computer’s startup disk.

m In Mac OS X, choose System Preferences from the Apple (K) menu and click Startup 
Disk, then select your hard disk.

m In Mac OS 9, choose Control Panels from the Apple (K) menu, then choose Startup 
Disk from the submenu, and select your hard disk.
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If you hear tones during startup: 

m If you recently installed additional memory, a PCI expansion card, or another internal 
component, make sure that it is correctly installed and that it is compatible with your 
computer. See if removing it allows the computer to start up.

m Contact an Apple-authorized service provider.

If you are unable to eject a disc:

A file on the disc may be in use. Quit applications that are open, then try again.

If that doesn’t work:

m In Mac OS X, choose Restart from the Apple (K) menu and hold down either the mouse 
button or the Media Eject (C) key on your Apple Pro Keyboard.

m In Mac OS 9, choose Restart from the Special menu and hold down either the mouse 
button or the Media Eject (C) key on your Apple Pro Keyboard.

Software Problems

If you have a problem with a software program:

m Use Software Update to ensure that you have the latest drivers, bug fixes, and other updates.

m For problems with software from a manufacturer other than Apple, contact the 
manufacturer.

If you have a problem using your computer or working with the Mac OS: 

m Look at the Help Center (in the Help menu) for instructions and troubleshooting 
information.

m Go to the Apple Support website on the Internet for the latest troubleshooting 
information and software updates:  www.apple.com/support
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If you have trouble using AirPort wireless communication:

m Make sure you have properly configured the software according to the instructions that 
came with your AirPort Card or AirPort Base Station.

m Make sure the computer or network you are trying to connect to is running and has a 
wireless access point.

m Make sure you are within antenna range of the other computer or the network’s access 
point. Nearby electronic devices or metal structures can interfere with wireless 
communication and reduce this range. Repositioning or rotating the computer may 
improve reception.

m See AirPort Help (in the Help Center) and the instructions that came with the wireless 
device for more information.

Problems With Your Display

No image appears on the screen.

m Make sure the display and computer are turned on.

m Make sure the cables are connected properly to your computer and the display.

m Make sure your computer is not in sleep. Press the power button or any key to see if the 
computer wakes. 

m Make sure the display brightness and contrast are set properly. Some monitors have 
brightness and contrast controls on or under their front edge.

m Reset the PRAM by restarting the computer while holding down the Command (x), 
Option, P, and R keys until you hear the startup sound a second time. Then start up using 
the Software Install CD.

m If that doesn’t work but your display is functioning, then it is a software problem. Restart 
your computer while pressing the Shift key to restart with your extensions off.

The screen image appears dim or flickers.

m Adjust the display brightness and contrast settings. Some monitors have brightness and 
contrast controls on or under their front edge. Depending on how dim your monitor 
appears, you may be able to adjust brightness or contrast using the Displays pane of 
System Preferences (in Mac OS X) or the Monitors control panel (in Mac OS 9).

Warning   If you have a problem with your Apple display and nothing presented in this 
manual solves it, contact an Apple-authorized service provider or Apple for assistance. 
If you attempt to repair the display yourself, any damage you may cause to the display 
will not be covered by the limited warranty on your display. Contact an Apple-authorized 
dealer or service provider for additional information about this or any other warranty 
question.
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m Calibrate the monitor. 

m In Mac OS X, choose System Preferences from the Apple (K) menu, click Displays, 
select Color, and click Calibrate.

m In Mac OS 9, choose Control Panels from the Apple (K) menu, then choose Monitors 
from the submenu and click Calibrate. The Calibrate option is not available on some 
displays.

m The flickering may be caused by interference from a nearby power line, a fluorescent 
light, or an electrical device—for example, a radio, a microwave oven, or another 
computer. Try relocating nearby electrical devices or moving your computer and display.

No colors appear on the screen or the colors don’t look right.

m Make sure the display is connected firmly to the computer.

m Calibrate your monitor, as described previously. For more information on color and your 
display, see Mac Help.

m Use the Displays pane of System Preferences (in Mac OS X) or use the Monitors control 
panel (in Mac OS 9) and make sure your monitor is set to display colors. For more 
information on color and your display, see Mac Help.

After you change the screen resolution, desktop icons move.

m Changing the screen resolution affects the display of information on your screen. 
The operating system may reposition icons after you change the screen resolution.

The screen freezes.

m Force the application that has frozen to quit.

m In Mac OS X, choose Force Quit from the Apple (K) menu and select the application.

m In Mac OS 9, hold down the Esc, Option, and Command (x) keys and click Force Quit 
in the dialog box.

m If that doesn’t work, force the computer to restart by pressing the reset button (P) on 
the front of your computer. 

The light on the front of the monitor is flashing.

On some Apple flat-panel displays, the power light displays a series of short flashes when an 
error has been detected. 

m If you see a repeating sequence of three short flashes, the monitor is detecting input in 
the wrong video format. Check that your monitor is compatible with your graphics card 
and that you’ve installed the correct monitor software, if your monitor came with 
installation software. 

m If you see a sequence of two short flashes and a long flash, the monitor is detecting a 
problem with a backlighting lamp. Contact an Apple-authorized dealer or service provider. 
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Restoring Your Computer’s Software

Software Restore restores your computer’s original contents, including the Mac OS 9 system 
software, factory settings, and applications that came with your computer.

Software Restore does not restore Mac OS X, iPhoto, iMovie, or iTunes. If you need to 
reinstall Mac OS X or these applications, use the Mac OS X installation discs that came with 
your computer.

After reinstalling Mac OS X, should you need to restore the rest of your computer’s 
applications and files, first install the Software Restore application, located on the first 
Software Restore CD, and then follow the onscreen instructions.

To restore your computer’s original contents:

1 Make sure you have all the Software Restore CDs that came with your computer.

2 Insert the first Apple Software Restore CD. Double-click the “SoftwareRestore.pkg” icon to 
install the Software Restore application.

3 Follow the onscreen instructions.

Important  It is highly recommended that you back up the data on your hard disk before 
restoring software. Apple is not responsible for any lost data.
90 Chapter  6  



A P P E N D I X

A

A Specifications

Processor and Memory Specifications 

Processor

m PowerPC™ G4 processor with 256 kilobytes (KB) on-chip cache

Random-access memory (RAM)

m Synchronous Dynamic Random-Access Memory (SDRAM) up to a maximum of
1536 MB (1.5 GB)

m All SDRAM is supplied in removable Dual Inline Memory Modules (DIMMs).

m Three slots are available for DIMMs that are 

m “PC-133” SDRAM DIMMs 

m 128, 256, or 512 MB DIMMs

256 MB DIMMs must have 128 or 256 megabit (Mbit) technology devices; 512 MB DIMMs 
must have 256 Mbit technology devices.

m 3.3 volt ( V ) unbuffered, 64-bit wide, 168-pin

The Mac OS system software provides information about your computer, including the 
amount of memory.
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Dimensions and Operating Environment 

Dimensions

m Weight:  15.9 kg, 35 lbs.

Weight depends on configuration. Weight above includes basic configuration, optical 
drive, Zip drive, and one hard disk drive. Weight may be greater if optional devices
are installed.

m Height:  432 mm, 17.0 in.

m Width:  227 mm, 8.9 in.

m Depth:  468 mm, 18.4 in.

Operating environment

m Operating temperature:  10° to 35° C (50° to 95° F)

m Storage temperature:  –40° to 47° C (–40° to 116.6° F)

m Relative humidity:  5% to 95% (noncondensing)

m Altitude:  0 to 3048 meters (0 to 10,000 feet)

CD-RW Drive Specifications

m Disc diameters supported:  12 cm (4.7 in.)

Data formats

m CD-ROM

m CD-Audio

m CD-R

m CD-RW

m CDI

m CD Bridge

m CD Extended

m CD Mixed Mode

m Photo CD

m Video CD

m 3-inch circular CD (6.75 cm)

m non-circular CDs
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Combo Drive (DVD-ROM/CD-RW) Specifications

m Disc diameters supported:  12 cm (4.7 in.)

Data formats

m CD-ROM

m CD-Audio

m CD-R

m CD-RW

m CDI

m CD Bridge

m CD Extended

m CD Mixed Mode

m Photo CD

m Video CD

m DVD-Video

m DVD-ROM

m DVD-R (read only)

USB Specifications 

m Support for USB 1.1

m Two external Universal Serial Bus (USB) Type A ports

m Each port is on a separate 12 megabit per second (Mbps) USB channel.

m 500 milliamperes (mA) at 5 V are available per port for a total of 1 ampere.

FireWire Specifications 

m Data transfer speed:  100, 200, and 400 Mbps

Power

m Input voltage range:  8 to 33 V

m Input power:  Approximately 1 watt ( W )

m Output voltage range:  Approximately 13 to 30 V

m Output power range:  Up to 15 W
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Ethernet Specifications 

m IEEE 802.3 compliant

m Maximum cable length:  100 meters (m)

m Protocols:  Open Transport, AppleShare, AppleTalk, NetWare for Macintosh, TCP/IP

m Connector:  RJ-45 for 10Base-T, 100Base-TX, and 1000Base-T

m Media, 10Base-T:  Category 3 or higher UTP on 2 pairs up to 100 m

m Media, 100Base-TX:  Category 5 UTP on 2 pairs up to 100 m

m Media, 1000Base-T:  Category 5 and 6 UTP on 4 pairs up to 100 m

m Channel speeds:  IEEE Auto Negotiation of 10Base-T, 100Base-TX, and 1000Base-T

Modem Specifications

m Data communications standard:  K56Flex and V.90

m Speed:  53 kilobits per second (Kbps)

m Fax standard:  ITU V.17

Specifications for the AirPort Card (Optional)

m Wireless data rate:  Up to 11 Mbps

m Range:  Up to 168 feet (data rates may vary depending on environmental conditions)

m Frequency band:  2.4 gigahertz (GHz)

m Radio output power:  15 dBm (nominal)

Compatibility

m 802.11 Direct Sequence Spread Spectrum (DSSS) 1 and 2 Mbps standard

m 802.11 HR DSSS 11 Mbps standard 

Audio Output Specifications 

m 16-bit stereo sound with audio sampling rates of 44.1 kilohertz (kHz)

Sound out using the Apple speaker mini-jack

m Compatible with only Apple Pro speakers; other speakers should not be used.

Sound out using the headphone jack

m Full-scale output level:  3.0 V peak-to-peak with an 8 kilohm load

Noise, distortion, and bandwidth

m Output sound signal-to-noise ratio (SNR) less than 80 decibels (dB) unweighted (typical)

m Distortion:  Total harmonic distortion:  0.08 percent

m Bandwidth:  20 hertz (Hz) to 20 kHz
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Graphics Controller

m AGP card with Apple Display Connector (ADC) and Digital Visual Interface (DVI) 
connector.

Video Display Modes

For technical specifications for your specific display, go to the Apple Web site and check the 
specifications for your product at www.apple.com/displays

Power Supply 

AC line input

m Line voltage/current:  100–120 V alternating current (AC), 8 amperes (A) or 
200–240 V AC, 4.5 A, single phase, manually set by voltage selector switch or set 
automatically depending on the type of supply

m Frequency:  50–60 hertz (Hz)

DC monitor output

m 4.0 A maximum at 25 V DC from the Apple Display Connector

Power Requirements for Devices You Can Connect

Expansion cards

m Maximum power consumption by the AGP card is 20 W.

m Maximum power consumption by four PCI cards and the AGP card combined is 80 W.

USB devices

m Each of the computer’s built-in USB ports is allotted 500 mA. 

FireWire devices

m The computer can provide up to 15 W total to the FireWire ports.

System Clock and Battery 

m CMOS custom circuitry with long-life lithium battery. You can replace the computer’s 
battery (see “Replacing the Battery” on page 83) with a new one purchased from an 
Apple-authorized dealer.
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B

B Safety, Maintenance, and Ergonomics

This appendix provides important information about safety procedures, routine 
maintenance, and ergonomic considerations for using your computer and display.

Important Safety Information

The only way to disconnect power completely from your computer is to unplug the power 
cord from the main power supply. To disconnect your display completely, you must also 
unplug its power cable from the computer or power outlet. Make sure at least one end of the 
device’s power cord is within easy reach so that you can unplug the computer or display 
when necessary.

For your own safety and that of your equipment, always take the following precautions.

Disconnect the power plug from your computer or display if any of the following 
conditions exists:

m the power cord or plug becomes frayed or otherwise damaged

m you spill something into the case

m your computer or display is exposed to rain or any other excess moisture

m your computer or display has been dropped or the case has been otherwise damaged

m you suspect that your computer or display needs service or repair

m you want to clean the computer or display case or screen 
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To prevent accidents and damage to your computer or display, be sure that you always follow 
these instructions:

m Keep your computer and display away from sources of liquids and moisture.

m Don’t set anything on top of the computer or display.

m Keep the computer and display vents free from obstruction.

m Never remove the case from the monitor or open your computer when it’s running. You 
could come in contact with hazardous voltage.

m During lightning storms, disconnect your modem from the phone jack to prevent a 
destructive voltage overload from damaging the modem.

Your Macintosh is equipped with a three-wire grounding plug—a plug that has a third 
grounding pin. This is a safety feature. Don’t modify the plug to fit into an ungrounded 
outlet. Contact a licensed electrician to replace the outlet with a properly grounded one. 
Do not defeat the purpose of the grounding plug!

Be careful when lifting or moving your computer or monitor. Be sure to use correct lifting 
procedures, lifting with your legs. When carrying the monitor, make sure the monitor is 
facing you. Don’t carry the monitor by its stand.

Apple and the Environment

At Apple, we recognize our responsibility to minimize the environmental impact of our 
operations and products.

For More Information

Go to www.apple.com/about/environment

Warning  Electrical equipment may be hazardous if misused. Operation of this product 
by children must always be supervised by an adult. Do not allow children access to the 
interior of any electrical product and do not permit them to handle electrical cables.
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General Maintenance

If you need to clean the computer or display beyond wiping it down with a clean cloth, 
follow these instructions:

1 Turn your computer and display off.

2 Disconnect the computer power cable from the electrical outlet or power strip. If your 
display is connected to an outlet, disconnect it as well.

3 Disconnect the display’s cables from the computer.

4 Clean the display screen with soft, lint-free paper or cloth dampened with mild soap and water. 

5 Wipe the computer or display case surfaces lightly with a clean, soft cloth dampened with water.

Protecting Your Optical Drive

To keep your optical drive working properly:

m Position your computer so that the drive tray doesn’t bump into anything when it opens.

m Close the drive when you’re not using it.

m Do not put anything on the drive tray when it is open.

m Do not touch the lens with your fingers. Do not wipe the lens with a paper towel or other 
abrasive surface. If you need to clean the lens, see an Apple-authorized service provider 
for a lens cleaner.

m Keep your computer away from any source of moisture.

Warning  Do not spray liquid directly onto the display screen. Liquid could drip inside 
the display and cause electrical shock.

Important  Don’t use alcohol, aerosol sprays, solvents, or abrasives that might damage the 
finish on the case.
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Maintaining Your Display

To maintain your display and ensure its long life:

m Do not press on the surface of the display screen.

m Do not write on the screen or touch the screen with a sharp object.

m If you will not be using your display and computer for a day or more, turn off the 
computer and display or use Energy Saver.

m Turn off your monitor, turn down the brightness, or use a screen saver program that dims 
or varies the image on the screen when the computer is idle for a prolonged time. 

Important Ergonomic and Health-Related Information

Here are some guidelines for adjusting the furniture in your office to reduce glare and to 
accommodate your physical size and shape.

m An adjustable chair that provides firm, comfortable support is best. Adjust the height of 
the chair so your thighs are tilted slightly and your feet are flat on the floor. 

The back of the chair should support your lower back (lumbar region). Follow the 
manufacturer’s instructions for adjusting the backrest to fit your body properly.

m When you use the computer keyboard, your shoulders should be relaxed. Your upper arm 
and forearm should form an approximate right angle, with your wrist and hand in roughly 
a straight line. 

You may have to raise your chair so your forearms and hands are at the proper angle to 
the keyboard. If this makes it impossible to rest your feet flat on the floor, you can use a 
footrest with adjustable height and tilt to make up for any gap between the floor and your 
feet. Or you can lower the desktop to eliminate the need for a footrest. Another option is 
to use a desk with a keyboard tray that’s lower than the regular work surface.

m Position the mouse at the same height as your keyboard. Allow adequate space to use the 
mouse comfortably.

m Arrange the monitor so the top of the screen is slightly below your eye level when you’re 
sitting at the keyboard. The best distance from your eyes to the screen is up to you, 
although most people seem to prefer 18 to 28 inches (45 to 70 cm). 
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m Position the monitor to minimize glare and reflections on the screen from overhead lights 
and nearby windows. If possible, use a tiltable monitor stand. The stand lets you set the 
monitor at the best angle for viewing, helping to reduce or eliminate glare from lighting 
sources you can’t move.

For more information about health, safety, and maintenance, go to Apple’s Web site at 
www.apple.com/about/ergonomics

Thighs tilted slightly

Shoulders relaxed

Screen positioned to avoid
reflected glare

Forearms and hands
in a straight line

Forearms level
or tilted slightly

Lower back supported

Feet flat on the floor

Top of the screen at or slightly
below eye level (You may need
to adjust the height of your
display by placing something
under it or by raising your
work surface.)

Clearance under work surface

45–70 cm (18–28 in.)
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Communications Regulation Information

FCC Compliance Statement

This device complies with part 15 of the FCC rules. Operation is subject to the following two conditions: (1) This 
device may not cause harmful interference, and (2) this device must accept any interference received, including 
interference that may cause undesired operation. See instructions if interference to radio or television reception 
is suspected.

Radio and Television Interference

This computer equipment generates, uses, and can radiate radio-frequency energy. If it is not installed and used 
properly—that is, in strict accordance with Apple’s instructions—it may cause interference with radio and 
television reception. 

This equipment has been tested and found to comply with the limits for a Class B digital device in accordance 
with the specifications in Part 15 of FCC rules. These specifications are designed to provide reasonable protection 
against such interference in a residential installation. However, there is no guarantee that interference will not 
occur in a particular installation. 

You can determine whether your computer system is causing interference by turning it off. If the interference 
stops, it was probably caused by the computer or one of the peripheral devices. 

If your computer system does cause interference to radio or television reception, try to correct the interference 
by using one or more of the following measures:

m Turn the television or radio antenna until the interference stops. 

m Move the computer to one side or the other of the television or radio. 

m Move the computer farther away from the television or radio. 

m Plug the computer into an outlet that is on a different circuit from the television or radio. (That is, 
make certain the computer and the television or radio are on circuits controlled by different circuit 
breakers or fuses.) 

If necessary, consult an Apple-authorized service provider or Apple. See the service and support information that 
came with your Apple product. Or, consult an experienced radio/television technician for additional suggestions. 

Important  Changes or modifications to this product not authorized by Apple Computer, Inc., could void the 
EMC compliance and negate your authority to operate the product.

This product was tested for EMC compliance under conditions that included the use of Apple peripheral devices 
and Apple shielded cables and connectors between system components. It is important that you use Apple 
peripheral devices and shielded cables and connectors between system components to reduce the possibility of 
causing interference to radios, television sets, and other electronic devices. You can obtain Apple peripheral 
devices and the proper shielded cables and connectors through an Apple-authorized dealer. For non-Apple 
peripheral devices, contact the manufacturer or dealer for assistance. 

Responsible party (contact for FCC matters only):  Apple Computer, Inc. Product Compliance, 1 Infinite Loop M/
S 26-A, Cupertino, CA 95014-2084, 408-974-2000.

Industry Canada Statement

Complies with the Canadian ICES-003 Class B specifications. Cet appareil numérique de la classe B est conforme 
à la norme NMB-003 du Canada. Cet appareil numérique de la classe B est conforme à la norme NMB-003 du 
Canada.

VCCI Class B Statement
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European Community

Complies with European Directives 72/23/EEC and 89/336/EEC.

Laser Information

Warning  Making adjustments or performing procedures other than those specified in your equipment’s 
manual may result in hazardous radiation exposure.

Do not attempt to disassemble the cabinet containing the laser. The laser beam used in this product is harmful to 
the eyes. The use of optical instruments, such as magnifying lenses, with this product increases the potential 
hazard to your eyes. For your safety, have this equipment serviced only by an Apple-authorized service provider. 

If you have an internal Apple CD-ROM, DVD-ROM, or DVD-RAM drive in your computer, your computer is a Class 
1 laser product. The Class 1 label, located in a user-accessible area, indicates that the drive meets minimum safety 
requirements. A service warning label is located in a service-accessible area. The labels on your product may differ 
slightly from the ones shown here. 

Laser Specifications

Laser on pickup unit (when reading a CD):

m Type:  Semiconductor GaAlAs laser

m Wavelength:  790 nm

m Power out of objective lens:  3.3 mW

m Beam divergence:  horizontal 12º vertical 35º

Exposure to Radio Frequency Energy

The radiated output power of the optional AirPort Card is far below the FCC radio frequency exposure limits. 
Nevertheless, it is advised to use the wireless equipment in such a manner that the potential for human contact 
during normal operation is minimized.

Mouse and Keyboard Information

The Apple optical mouse is a Class 1 LED product. This product complies with the requirements of European 
Directives 72/23/EEC and 89/336/EEC.

It also complies with the Canadian ICES-003 Class B Specification.

High-Risk Activities Warning

This computer system is not intended for use in the operation of nuclear facilities, aircraft navigation or 
communications systems, or air traffic control machines, or for any other uses where the failure of the computer 
system could lead to death, personal injury or severe environmental damage.

ENERGY STAR® Compliance

As an ENERGY STAR® partner, Apple has determined that standard configurations of this product using the 
Mac OS X and Mac OS 9 operating systems meet the ENERGY STAR® guidelines for energy efficiency. The 
ENERGY STAR® program is a partnership with office product equipment manufacturers to promote 
energy-efficiency. Reducing energy consumption of office products saves money and reduces pollution 
by eliminating wasted energy.

Class 1 label Service warning label
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Telephone and Apple 56K Modem Information

Notify Your Telephone Company

Some telephone companies require that you notify the local business office when you hook up a modem to their 
lines. 

Information You Need in the United States 

The internal modem complies with Part 68 of the FCC rules. On the back of this equipment is a label that 
contains, among other information, the FCC registration number and ringer equivalence number (REN). If 
requested, provide this information to your telephone company. 

m Ringer equivalence number (REN):  0.6B The REN is useful for determining the quantity of devices you may 
connect to your telephone lines and still have all those devices ring when your telephone number is called. In 
most, but not all areas, the sum of the RENs of all devices connected to one line should not exceed five (5.0). 
To be certain of the number of devices you may connect to your line, as determined by the REN, you should 
contact your local telephone company to determine the maximum REN for your calling area. 

m Telephone jack type:  USOC, RJ-11 An FCC-compliant telephone cord and modular plug are provided with this 
equipment. This equipment is designed to be connected to the telephone network or premises wiring using a 
compatible modular jack that complies with Part 68 rules. See the installation instructions for details.

Telephone Line Problems

If your telephone doesn’t work, there may be a problem with your telephone line. Disconnect the modem to see 
if the problem goes away. If it doesn’t, report the problem either to your local telephone company or to your 
company’s telecommunications department. 

If disconnecting the modem eliminates the problem, the modem itself may need service. See the service and 
support information that came with your Apple product for instructions on how to contact Apple or an Apple-
authorized service provider for assistance. 

If you do not disconnect your modem when it is adversely affecting the telephone line, the telephone company 
has the right to disconnect your service temporarily until you correct the problem. The telephone company will 
notify you as soon as possible. Also, you will be informed of your right to file a complaint with the FCC. 

The telephone company may make changes in its facilities, equipment, operations, or procedures that could 
affect the operation of your equipment. If this happens, the telephone company will provide advance notice in 
order for you to make the necessary modifications to maintain uninterrupted service. 

The internal modem will not work with party lines, cannot be connected to a coin-operated telephone, and may 
not work with a private branch exchange (PBX). 

Telephone Consumer Protection Act 

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other 
electronic device to send any message via a telephone fax machine unless such message clearly contains, in a 
margin at the top or bottom of each transmitted page or on the first page of the transmission, the date and time it 
was sent and an identification of the business, other entity, or individual sending the message and the telephone 
number of the sending machine of such business, entity, or individual.

Information You Need in Canada 

The Industry Canada (IC) label identifies certified equipment. This certification means that the equipment meets 
certain telecommunications network protective, operational, and safety requirements. The Department does not 
guarantee the equipment will operate to a user’s satisfaction. 

Before installing this equipment, make sure that you are permitted to connect to the facilities of the local 
telecommunications company. Be sure you use an acceptable method of connection to install the equipment. In 
some cases, you may extend the company’s internal wiring for single-line individual service by means of a certified 
telephone extension cord. Be aware, however, that compliance with these conditions may not prevent 
degradation of service in some situations. 
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Repairs to certified equipment should be made by an authorized Canadian maintenance facility designated by the 
supplier. Any equipment malfunctions or repairs or alterations that you make to this equipment may cause the 
telecommunications company to request that you disconnect the equipment. 

In Canada, contact Apple at:  7495 Birchmount Road, Markham, Ontario, L3R 5G2, 800-263-3394

Warning  Users should ensure for their own protection that the electrical ground connections of the power 
utility, telephone lines, and internal metallic water pipe system, if present, are connected together. This 
precaution may be particularly important in rural areas. 

Users should not attempt to make such connections themselves, but should contact the appropriate electric 
inspection authority or electrician.

m Load number:  0.2 The load number (LN) assigned to each terminal device denotes the percentage of the total 
load to be connected to the telephone loop that is used by the device, to prevent overloading. The termination 
of a loop may consist of any combination of devices, subject only to the requirement that the sum of the load 
numbers of all devices does not exceed 100.

m Telephone jack type:  CA-11

Informations Destinées aux Utilisateurs Canadiens

L’étiquette d’Industrie Canada identifie un matériel homologué. Cette étiquette certifie que le matériel est 
conforme à certaines normes de protection, d’exploitation et de sécurité des réseaux de télécommunications. Le 
Ministère n’assure toutefois pas que le matériel fonctionnera à la satisfaction de l’utilisateur.

Avant d’installer ce matériel, l’utilisateur doit s’assurer qu’il est permis de la raccorder au réseau de l’enterprise 
locale de télécommunication. Le matériel doit également être installé en suivant une méthode acceptée de 
raccordement. Dans certains cas, le câblage appartenant à l’enterprise utilisé pour un service individuel à ligne 
unique peut être prolongé au moyen d’un dispositif homologué de raccordement (cordon prolongateur 
téléphonique).

L’abonné ne doit pas oublier qu’il est possible que la conformité aux conditions énoncées ci-dessus n’empêche 
pas la dégradation du service dans certaines situations. De fait, les enterprises de télécommunication ne 
permettent pas que l’on raccorde un matériel aux prises d’abonnés, sauf dans les cas précis prévus par les terifs 
particuliers de ces enterprises.

Les réparations de matériel homologué doivent être effectuées par un centre d’entretien canadien autorisé 
désigné par la fournisseur. La compagnie de télécommunications peut demander à l’utilisateur de débrancher un 
appareil suite à des réparations ou à des modifications effectuées par l’utilisateur ou en raison d’un mauvais 
fonctionnement.

Veuillez contacter Apple pour des informations supplémentaires:

Apple Canada, Inc.

7495 Birchmount Road

Markham, Ontario

Canada L3R 5G2

Service à la clientèle d’Apple Canada :  800-263-3394

Pour sa propre protection, l’utilisateur doit s’assurer que tout les fils de mise à la terre du secteur, des lignes 
téléphoniques et les canalisations d’eau métalliques, s’il y en a, soient raccordés ensemble. Cette précaution est 
particulièrement importante dans les régions rurales.

Avertissement  L’utilisateur ne doit pas tenter de faire ces raccordements lui-même; il doit avoir recours à une 
service d’inspection des installations électriques ou à un électricien, selon le cas.

m Numéro de charge :  0.2 L’indice de charge (IC) assigné à chaque dispositif terminal indique, pour éviter toute 
surcharge, le pourcentage de la charge totale qui sera raccordée à un circuit téléphonique bouclé utilisé par ce 
dispositif. La terminaison du circuit bouclé peut être constituée de n’importe quelle combinaison de dispositifs 
pourvu que la somme des indices de charge de l’ensemble des dispositifs ne dépasse pas 100.

m Type de prise téléphonique :  CA-11
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Information You Need in the United Kingdom

This terminal equipment is intended for direct connection to the analogue Public Switched Telecommunications 
Network and is approved for use within the United Kingdom with the following features:

m Modem facility

m Autocalling facility

m Autoanswer facility

m DTMF signaling

Operation in the absence of proceed indication or upon detection of proceed indication

This product is in conformity with relevant regulatory standards following the provisions of European Council 
Directives 73/23/EEC (Low Voltage Directive) and 89/336/EEC amended by 92/31/EEC (EMC Directive).

Informationen fur Deutschland

Diese Modem-Karte ist als Endeinrichtung vorgesehen und muss an ein TAE mit F-Kodierung angeschlossen 
werden. Diese Endeinrichtung ist in Konformität gemäss Niederspannungsrichtlinie 73 / 23 / EWG sowie EMC-
Richtlinien 89 / 336 / EWG und 92 / 31 / EWG.

Informations pour la France

Ce matériel est conforme aux normes applicables de sécurité éléctrique d’après la directive 73 / 23 / CEE et aux 
normes applicables de comptabilité éléctromagnétique d’après la directive 89 / 336 / CEE, modifié par la directive 
92 / 31 / CEE.

Information You Need in Australia

All telecommunications devices are required to be labelled as complying to the Australian telecommunications 
standards, ensuring the health and safety of the operator and the integrity of the Australian telecommunications 
network. To provide compliance with the Australian Communications Authority’s technical standards, please 
ensure that the following AT commands are maintained:

m ATB0 (ITU/CCITT operation)

m AT&G0 (no guard tone)

m AT&P1 (33/66 pulse dial make/break ratio)

m ATS0 = 0 or ATS0 = 1 (no answer or answer greater than one ring)

m ATS6 = 95 (DTMF period between 70–255 ms)

m ATS11 = 95 (DTMF period between 70–255 ms)

For calls that are automatically generated, a total of three call attempts are allowed to a telephone number, with a 
minimum period between calls of 2 seconds. If the call does not connect after three attempts, 30 minutes must 
expire before automatic redialing may be initiated. Failure to set the modem (and any associated communications 
software) to the above settings may result in the modem being non-compliant with Australian 
telecommunications standards. Under these circumstances a user could be subject to significant penalties under 
the Telecommunications Act 1997.

This modem must be properly secured in order for you to use it. Telecommunications network voltages exist 
inside the computer and the telecommunications line connection must be removed before opening the 
computer.

Information You Need in New Zealand

This modem is fully approved to operate on the New Zealand telecommunications network under Telepermit 
number PTC 211/01/062. All telecommunications devices are required to hold a Telepermit and be labelled 
accordingly with the approved Telepermit number to comply with the New Zealand telecommunications 
standards, ensuring the health and safety of the operator and the integrity of the New Zealand 
telecommunications network. To ensure compliance, all calls that are automatically generated should not make 
more than 10 call attempts to the same number within any 30 minute period with a minimum period between 
calls of 30 seconds. Failure to adhere to these standards may result in the modem being non-compliant with New 
Zealand Telecom standards. Under these circumstances a user could be subject to significant penalties.
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Important  The grant of a Telepermit for any item of terminal equipment indicates that only Telecom has 
accepted that the item complies with minimum conditions for connection to its network. It indicates no 
endorsement of the product by Telecom, nor does it provide any sort of warranty. Above all, it provides no 
assurance that any item will work correctly in all respects with another item of Telepermitted equipment of a 
different make or model, nor does it imply that any product is compatible with all of Telecom’s network services.
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